

    
      
          
            
  
Misura™ documentation project

Misura™ is the data acquisition and analysis software platform for non-contact high temperature measurement instruments.

Please always refer to the updated version of this document which can be found online here:


http://misura.readthedocs.io
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Installation

This document describes the installation and quick start of Misura™4 software.


Prerequisites


	2GB of free hard disk storage


	At least 500MB of free RAM at runtime (see below)


	2Ghz, dual core processor


	Maximum screen resolution: 96dpi.




For windows:
- Windows 10 64bit
- 4GB RAM for ODP users
- 8GB RAM for Flash users

For linux:
- Ubuntu 16.04
- 2GB RAM for general users
- 8GB for Flash users

Dependencies:


	The latest Windows Visual C++ 2008 Redistributable package, x86 version (independently on your OS being 64 or 32 bits): vcredist [https://www.microsoft.com/en-us/download/details.aspx?id=29].


	You will need Xvid [https://www.xvid.com/download/] MPEG4 video compression filter in order to export compressed videos of recorded frames.




Known incompatibilities:


	High DPI screens might not be supported and cause Misura to crash. Please




rescale to 96 DPI.




Microsoft Windows™ 10 64bit

Misura™4 for Microsoft Windows™ 1064bit can be obtained as a standard installer (.exe).

Installation initiates by double clicking on the installer package proceeding through the pages.
Any previous installation will be deleted, but local Misura data and configuration will not be affected.

The installer will ask which components to install. Misura Flash users can skip the
installation of Acquisition and Graphics components.


Upgrading

The Misura™ Browser menu action Help ‣ Check client updates will check if any newer client version is available,
download the installer and start the installation procedure.

The Live Acquisition window also offers Help ‣ Check server updates when connected to an instrument.
This action upgrades the instrument’s firmware, closes the client and restarts the server.






Canonical Ubuntu™ GNU/Linux

Misura™4 for Ubuntu™ 14.04 LTS GNU/Linux operative system should be installed along with the full development environment.

Follow instructions contained in the README [https://github.com/tainstr/misura.client].

Both client and server upgrades are available as explained above, Upgrading.




Bug reports and support

For assistance you can contact Daniele Paganelli, d paganelli at tainstruments .com.

The Help menu of Misura™ Browser and Live Acquisition contains a Bug report action which will create a zip archive
containing useful information for debugging, Help ‣ Bug report. It is recommended to attach this archive to any support request.


	If the issue involves running a test or controlling an instrument, the bug report should be created from Live Acquisition while connected to the machine.
In this way also instrument logs will be included.


	If the issue involves only data processing and visualization, the bug report can be created from the Misura™ Browser.


	If doubts about measurements are implied, please send also relevant test files.




It is advisable to set the client bug level filter to 0, so all user interface messages will be logged (Logging level option in Preferences).







          

      

      

    

  

    
      
          
            
  
The Measurement Platform

This section describes software components that are shared across all or many Misura applications. They are presented in a general way which is applicable to any measurement task.
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Live Acquisition

The Live Acquisition software allows to carry on any kind of measurement available on a Misura platform.

This section describes basic concepts, functionalities and procedures which are general enough to be applicable to any measurement.

More specific instructions can be found in Measurement Apps sections dedicated to each instrument.


Connecting

When you first launch Acquisition software, you have to select a server to connect to.

Select the Connect ‣ Server ‣ Open action. Alternatively, from the Recent Servers area, click the Add button:

[image: _images/empty_acquisition.png]
An input dialog will let you specify the server protocol, IP, port and path. In a normal environment, the server address will be:


https://192.100.100.100:3880/RPC




[image: _images/connection_dialog.png]
A username and a password will be prompted, and saved for any future connection to that machine.

[image: _images/login_dialog.png]
Saved connections will be displayed both as items in the Recent servers box on the welcome page of Live Acquisition,
and as Connect ‣ Server menu items.


Client network configuration

You should connect to the instrument through a crossover cable or a private hub just between the client PC and the instrument network interface.

As the instrument provides no network auto-configuration, you will be required to manually set-up your network interface in order to be able to reach that IP.

Factory-installed clients usually have this configuration:


	IP: 192.100.100.2


	Netmask: 255.255.255.0


	Gateway and DNS: None




Follow this official guide for Windows [https://support.microsoft.com/en-us/help/15089/windows-change-tcp-ip-settings] to disable DHCP and manually set a fixed address.




Time synchronization

The time between instrument and client computer is kept synchronized. The user may periodically see a warning message upon connection, asking to re-synchronize times. If replied positively, the instrument will restart for synchronization.

It’s up to the user keep the client’s computer time up-to-date, manually or by using exact time services.

When connecting from multiple clients, you should keep all client synchronized at the same time, to avoid multiple re-sync.






Initializing the Measurement App

After a successful connection you will be shown a list with available Measurement Apps, a button for each instrument. Click the corresponding button to select your desired instrument.

Once the instrument is selected, the machine will start its setup, also called measurement morphing. A “Pending Tasks” dialog will appear in the left panel, showing some details about what is happening. The internal positions of measuring components will change in order to reach the configuration required to perform the requested instrument, as displayed in this video [https://youtu.be/aWvrPV9Mtt4?t=58s].

This operation can take up to a couple of minutes, depending on the instrument. Any interaction with the application is discouraged until when the dialog disappears.

Once the initialization is complete, the application will display all relevant controls needed to configure, start and follow the execution of the test.


	The menu bar contains:

	
	Connect: to connect to a different machine or to change measurement app.


	Measure: allows to re-initialize the instrument from zero, set a delayed start, hide/show user interface components (Test Configuration, Storyboard, Data Plot, Data Table, Log Window), Reload Data from the instrument, Quit client.


	Settings: gives access to advanced configuration panels for the Instrument itself, its individual Devices, or the full Global configuration.


	View: Hide/show user interface components, like plot window, storyboard, etc.


	Help: client configuration, documentation link opening the documentation you are reading, the Pending Tasks dialog, the software information dialog.






	On the right side of the window you find a tabbed Test Configuration area, showing:

	
	Status tab: contains short summary of the current test condition. The first two options shows if a test is running (data recording) and if the thermal control is active. They are underlined in green when not active, in red when running. Then follows information on test name and test duration (if running); the furnace position if motorized; temperatures, setpoint and power output. More sample-dependent option can be shown based on the active measurement app.


	Measure tab: generic test configurations can be made (starting and stopping conditions) and metadata can be viewed (eg: maximum temperature reached)


	Thermal Cycle tab: allows to define the thermal cycle and preview it


	Sample<N> tabs: one tab for each sample defined in the analysis.


	Results tab: empty until the start of the test. Will be populated with tools for Interacting with a running test.






	On the bottom, a bar showing:

	
	Focus slider and spin-box, to adjust the focus distance.


	Furnace: option to view and control furnace position (Opened/Closed). Only available if furance is motorized.











Configuring the test

The following paragraphs explain common procedures or concepts needed to carry out any test with Misura™.


Moving the furnace

The first step of test configuration is placing the sample in the right position. If the furnace is motorized, you should always open it by using the option Is the furnace closed? in the Status tab, or the Furnace: box in the bottom bar. That option should be changed to the desired position: Closed or Opened.

Once the sample is positioned and correctly framed, it is advisable to close the furnace using the same option, and proceed with test configuration.




Measure and Sample names

The test name can be directly set in the Status panel, or in the Measure tab.

This is the name of your measurement, but the sample (and each sample) can have a different name. Sample names can be set in their Sample<N> tab, in Name option (see Samples).

The test name should identify the kind of measurement, while the sample name should identify the material the measurement method is applied to. You will be able to recall the both test name and sample name from the Database Indexes.

For simplicity you can just set the test name to a string identifying both the kind of test and the sample name, and leave the sample name field to the default value (Sample N. 0).

The test name will also be used as the output file name. If a file with the same name already exists, it will be postfixed with _<N>, where <N> will be increased until an unique name exists (measure, measure_1, measure_2, etc).




Thermal cycle

The Thermal Cycle tab in the Test Configuration area allows to load a thermal cycle preset or to design a new one. Refer to Thermal Cycle Designer for a detailed explanation.

Additional test termination options can be configured in the Measure and Sample sections, depending on the Measurement Apps you are using.






Measure

This tab contains:



	Configuration preset: a combo that allows you to load a previously saved configuration. Save and Del buttons respectively save and delete currently selected preset.


	Name: the name to give to the test.


	Maximum test duration: defines the amount of passed time that will cause the end of the test, even if the thermal cycle is not completed (-1 removes this timeout)


	Stop after thermal cycle: when set, the acquisition will stop when the thermal cycle is over. If not set, the acquisition will go on until the operator won’t stop it manually.


	Operator: the operator running the test


	Type: the type of test. Only Standard is supported to date


	Start at: date and time when the test was started


	Number of samples: sets the number of samples to analyze (can be from 1 to 8)


	Kiln position before acquisition: the position where the kiln will be placed right before the start of the acquisition


	Kiln position after acquisition: the position where the kiln will be placed after the end of the acquisition


	End status: displays the reason of the acquisition’s termination










Samples

Every sample has its own tab, named Sample0, Sample1, …

Each tab contains the details of its sample:



	Configuration preset is the currentrly loaded preset. You can change it, save it if you make any change, and delete it.


	Name is the name of the sample


	Temperature is the current sample temperature


	Initial sample dimension is the size of the specimen, before the start of the test


	Record frames defines wether tha raw frame of the sample should be saved or not


	Record profiles defines wether the sample profiles have to be saved or not


	Border angle is the angle of currently detected border


	Total displacement is the current displacement from initial position










Starting/stopping the test

Once the test is completely configured, the sample positioned and the furnace moved to its intended initial position,
you can start it by clicking on Start button in the upper-left toolbar.
A confirmation dialog will ask you to review the test name, the initial dimension if any, and the system status.
By confirming, the test will start.

The button bar in the upper side of the main window has two more buttons, Stop and Cool, as explained in Ending the test.


Delayed start

To schedule a test to start at a specified date in the future, you can use the Delayed start feature, available from the Measure menu.

[image: _images/delayed_start.png]
The Delayed Test Start dialog will appear with the options needed to control its behaviour.


	Enable delayed start: click on the checkbox to engage the delayed start. When the configured time and temperature are reached, the test will automatically start.


	Delayed start date: Set date and time when the test will start.


	Delayed temperature: Set a required minimum temperature for the start of the test. If set to -1, no temperature will be required and only the time delay will be considered.




Then 3 fields allows to understand how and when the test will be started.


	Target instrument: the current instrument app name. It will not be possible to change instrument a delayed start is already configured.


	Remaining time: a countdown showing remaining time to test start


	Operator: the user name of the operator who set the delayed start




Finally, 2 buttons:


	Save and exit: close the client application. The delayed start will remain active and the test will be started at the configured time, even if no client is connected to the instrument.


	Abort delayed start: cancel delayed start and dismiss the dialog.




The dialog will remain active until the test starts. If you close the client application or click Save and exit, the delayed start will remain effective. If you later reconnect to the instrument, the delayed start dialog will pop up again, until test starts or delayed start is aborted.

Dismissing the dialog equals aborting the delayed start.






Interacting with a running test

While the test is running it is possible to perform most of the data visualization and processing operations which are available when accessing to a finished test output file.


	The Status panel tab will update showing relevant options and output values


	By clicking on menu Measure ‣ Data Plot, you can view a realtime graph of output values which will open in a Data Plot subwindow.
You can interact with the plot under the Results tab (adding a curve, changing visualization options, etc).


	By clicking on menu Measure ‣Data Table, you can inspect all active datasets in a tabular view, which will open in a Data Table subwindow.


	If the instruments records images or sample profiles, the Storyboard will be visible.





Status panel

The Status panel will update showing relevant status, configuration options and real-time output values.

It always contains information about:



	Acquisition status: is there a running test? This coloured checkbox will be False over green background when there is no running test; True over red background while a test is running.


	Thermal control status: is there any running thermal cycle? This coloured checkbox will be False over green background when there is no active thermal control (no thermal cycle); True over red background if the temperature is currently under control by a thermal cycle.


	Test name. This text box is synchronized with the one contained in the Measure tab.


	Elapsed time: Seconds passed since the start of the test.







Thermal control status cannot be True if the acquistion status is False. In other words, temperature cannot be controlled by a thermal cycle outside of a running test.

On the opposite it is possible that the thermal control is turned off during a running test. This happens if the test was set to do not end with the thermal cycle and its target duration was longer than the duration of the thermal cycle. The operator can also manually interrupt the thermal control anytime by pressing the Cool button - without stopping the acquistion (see below Ending the test).

The Status panel also contains real-time thermal control parameters, as:



	Sample temperature: Temperature measured as near as possible the sample, on the sample holder.


	Furnace temperature: Also measured quite near the sample, but attached to the furnace chamber. Thus, if the furnace opens, this thermocouple signal will record the inside of the empty furnace, while the Sample temperature above will record the environment temperature outside of the furnace, nearby to the sample.


	Setpoint: The target temperature of the thermal cycle.


	Power: The percentage of power emitted in order for the control temperature to reach the setpoint temperature.


	Control temperature: The reference temperature used for power emission in order to reach the setpoint. This is usually equal to the Sample temperature while the furnace is closed; to the furnace temperature while it is open; or to a custom combination of both.







Additionally, the Status panel contains realtime values depending on the current Measurement App:



	Initial sample dimension


	Displacement (expansion/contraction/flexion)


	Volume


	Height


	…










Data Plot

The Data Plot is accessible by clicking on menu Measure ‣ Data Plot. It is initialized at the start of the test with a default plot showing the most relevant measured property against time.

The plot can be edited and customized exactly as you would offline using the Misura™ Browser or the Plotting. See Data Plot for more help.


Warning

It is advisable not to build complex plots during live acquisition, as you will loose all your careful work when the test ends. Moreover, complex data operations might slow down the user interface and lead it to a complete freeze, as they are entirely re-computed each time a new data point is received. If this happens, close the Live Acquisition window and reconnect to the running machine. Plotting data has no effect on test execution, measurement, and data collection.




Hint

The data you see during live acquistion is not exactly the same you will find on the output file. This is because the data plot will display raw values as they arrive each couple of seconds. Instead, when you open the output file after the test ended, you will plot slightly smoothed data considering tens of points per second.






Results

The Results tab contains another series of tabs, which are:



	Data Tab: a tree that contains all plottable data to allow you to perform operations over it.


	Properties and Formatting: are the equivalent of Properties and Formatting on the right click menu of the Data Plot. Operations are applied on the object selected in the Objects tab or on the plot.


	Objects is a 1 to 1 representation of the plot; it allows to select objects to perform operations in other contexts.


	Console is the Veusz output console.










Data Table

The Data table is accessible by clicking on menu Measure ‣ Data Table. It displays one column for each Loaded Dataset.

New data points are dynamically added at the end of the table. The table can be exported to *.csv file format anytime by right-clicking on the header.




Storyboard

The storyboard displays a list of recorded frames or profiles of a sample. The target sample can be changed with the upper-left combo box.

The storyboard is available only when images or profiles are saved in the output file.
Frame and profile recording can be configured, before test start, in the Sample <N> tabs in Test Configuration panel.

It is always visible in the Microscope app. If not, it can be accessed by clicking on menu Measure ‣ Storyboard.

A label below each image reports the temperature value at which the image was recorded (eg: T: 321).
More measured values can be displayed by dragging and dropping nodes from the Results tab.

The number of images is fixed (usually five on an horizontal row).

The user can navigate forward and backward by using the upper slide bar, which will cause the images to update to the recorded data in the position indicated by the slider, relative to total test duration.

Navigating through the images will cause a vertical red line to move back and forth in the Data Plot, if visible.
The operator can thus view measured values associated with displayed images.

It is possible to navigate through the images also by dragging and dropping the red bar on the Data Plot to different X-axis values.






Ending the test

The test will naturally end when a termination option is triggered (end of thermal cycle, test duration elapsed, etc).
At the end of the test, the output file will be downloaded to the client PC - if the client is connected - or scheduled for download with the Storage synchronization mechanism.

To forcefully stop the test, click Stop button in upper-left toolbar. You will be asked to confirm your decision, and if you want to save the partial output file or immediately delete it.

In certain conditions it is useful to stop the thermal control without stopping the test. Click the Cool button in the upper-left toolbar and confirm your decision. The confirmation dialog will warn you that, in order to stop the thermal cycle without stopping the test, the option Stop after thermal cycle was implicitly disabled. If you did not provide a maximum duration for your test, or other special termination option, it is possible that your test will never end.

Never ending tests are possible by disabling the Stop after thermal cycle option and setting a zero or negative Maximum test duration.
It’s up to you to manually stop these tests.

Changing termination options has immediate effect on the running test.
For example, if the thermal control ended and enable the Stop after thermal cycle option, the test will instantly stop.
Or, if you set a maximum test duration greater than zero but smaller than current elapsed time.







          

      

      

    

  

    
      
          
            
  
Components and options

The configuration of a test involves many different components of the system: the measurement definition, one or more samples, the thermal cycle.

Under the hood, many other components are configured automatically or based on the user’s input: real physical devices (cameras, motors, power controllers, etc)
and virtual components like sub-samples (Left/Right/Center, Base/Heigt), feedback regulators, the instrument itself, etc.

All these configurations are defined and saved in a consistent hierarchy of components both in the live instrument and in the output file.

Each component defines several options: all summed up, they represent the component’s configuration.
Component configurations can be saved as Configuration presets, and recalled by their name to quickly get the component back in the desired configuration.

The user interface displays a component configuration as a Configuration panel:
a structured list containing all available options (according to the user’s Access Management).

Components are organized in a hierarchical way, in order to make easier to search for them and to automate some actions on group of related components.


Configuration panel

A configuration panel lists all options related to a single component. For example, left-side panel in Configuring the test, is a configuration panel.

It can contain tabs, one for each major configuration section.
For example, shape identification standards, listed as tabs in microscope Standards for Characteristic shapes identification,
are configuration sections.

The options listing can be divided up to 3 boxes, one for each option role:


	Configuration: options which can be edited by the user.


	Status: options which are generally changed server-side to reflect internal status. The user can interact with some of them.


	Results: options which represent the output of a server process - usually read-only.




Box visibility can be toggled by clicking on the checkbox near the header.

[image: ../_images/config_sections_collapsed.png]



Configuration options

Misura™4 offers a unified experience to visualize and edit any variable, generically called Option.

Options can represent proper Configuration variables, which the user can change to obtain an effect,
but also the Status of some server-side variable, or a read-only Result from an analysis.

This distinction is well visible in any configuration panel, where options are grouped in 3 boxes - one for each role.

Options have types (String, Integer, Float, etc) which determine their appearance in the user interface.

All options share a common representation pattern: a label, containing the option’s name, and the option value.
The option value can be represented as an input box (for text), a spinbox (for numbers), a slider and a spinbox (for number with boundaries),
a combo-box (for selections), a checkbox (for booleans), etc.

Read-only options usually appear as simple text labels, without any control associated with editing. Some read-only option types, like tables, have no visual distinction:
editing interactions are simply disabled.

If a numerical option has an associated measurement unit, it will be displayed between the label and the value.


Sub-options and groups

An option can have sub-options, which are hidden by default. Sub-options usually represent fine-tuning aspects of the parent option.

The presence of sub-options is indicated by a + symbol on the right of the option itself.
When clicked, subordered options will become visible below the main option, and the symbol will turn to - and produce the opposite effect (hiding sub-options).

Options might be grouped together in a titled box.

[image: ../_images/sample_geometry.png]



Option’s context menu

The options’s context menu can be visualized by right-clicking on the option’s label. Actions marked with (*) are available only when connected to a live instrument.


	enabled: some options might support an enabled/disabled state.


	Units: Change measurement unit. Only for numerical options defining a number.


	Set default value: resets to factory default.


	Check for modifications: (*) force to read the current value on the instrument’s side and refresh. It as the same effect as passing the mouse over the option.


	Option info: opens a dialog where all option’s attributes are listed.


	Detatch: opens a separate window containing the option label and value alone. This can be useful to view more clearly complex options, like tables.


	Aggregation: only visible if the option is an aggregate, se Aggregates.


	Presets: (*) lists all values in any saved configuration preset for this component. By clicking on a submenu action, the related value will be applied.





Compare menu

Compare lists all values for options with the same name in any other component on the server or in the test.
By clicking on a submenu action, the related value will be applied.

[image: ../_images/compare_menu.png]
When an option have some sub-options, a Compare menu is also accessible from the +/- symbols used for exploding or collapsing the option group.
This menu contains an intermediate level, listing all components containing all the options grouped together.
For there, another submenu lists the option values one by one.
By clicking on an option:value couple you can apply that value to the option in the current group.
By clicking on Apply all, all the values from the referred group will be imported and applied to the current group’s options.

[image: ../_images/compare_group_menu.png]



Range menu

[image: ../_images/range_menu.png]
Numerical options also show a Range submenu, containing settings for:


	Min: the minimum value the option can have


	Max: the maximum value the option can have


	Step: step used for user-interface interactions (spinbox, slider)


	Zoom: The control slider will be zoomed into a region of valid values and be colored in red.
This can be activated on options having a min/max and showing a slider. Zooming can be used in Motion Control.


	Precision: how many digits to show. They will be shown only if needed (eg: 1.20001 will be just 1.2 if precision is set to 4 or less).
A less than 0 value means digits are unmanaged.









Tables

Tabular options have more complex editing interactions and they offer 3 context menus accessible with right-clicks.


Cell context menu

Also callable from the empty space:


	Add row after or before


	Delete row - currently selected or first


	Update values from remote


	Copy selected contents to clipboard, in a text format which is suitable for pasting in third-party applications.


	Export to csv file, which can be imported in third-party applications.


	Rotate: exchange rows with columns. Will not affect underlining data structure nor csv export. Data copied to clipboard will be rotated.


	Zoom: graphically zoom in/out of the table, enlarging or shrinking all fonts and graphical elements


	Visible units: toggle visibility of column header units


	More columns: view previously hidden columns.


	More rows: view previously hidden rows.







Column and row header context menus


	Visible checkbox: uncheck to hide the column.


	More columns: view previously hidden columns again.


	
	Units: contains sub-actions related to measurement units management.

	
	Visible unit in the header.


	Select the current measurement unit.










	Use as header: will activate row header using this column.


	Export and Rotate as above


	Add row at the end of the table.




A Row header context menu is also available, containing the same options as the column header.
Visibility refers to the clicked row, and More rows allows to recall hidden rows.






Aggregates

The value of an option might be dynamically calculated according to options contained in other components.
In this case, the option is referred as an aggregate.

For example, an option might be defined as the mean, a sum, a product or a tabular representation of numerous other options.
Involved options typically come from sub components. For example, if component A has 3 sub components A/B, A/C, A/D and each of them defines a Temperature option,
component A might define an aggregated Temperature option which is defined by the mean of all its subcomponent’s temperatures:


A.Temperature = (A/B.Temperature + A/C.Temperature + A/D.Temperature) / 3




Aggregated options can be recognized because they offer an additional context-menu submenu: Aggregation (see Option’s context menu), containing these options:

[image: ../_images/aggregation_menu.png]

	Update: re-calculate the value of the aggregation.


	List aggregated options: opens a new window showing the values of options involved in the aggregation.




[image: ../_images/aggregation_dialog.png]
After a separator, all components involved in the aggregation are listed.
Each component opens a sub-menu, with a View action, which will open a Configuration panel for the aggregated component
where the involved option is highlighted in red.

[image: ../_images/aggregation_highlight.png]
A Navigator action is also available, giving access to the same actions which could be performed on the component’s node if selected in the Misura™ Navigator.

A special tabular aggregation produces a table, where each cell value derives from an option pertaining to another component.
An additional sub-menu is appended to the Cell context menu, with the same functionality as the View action above.

Tables can also be merged together, following the same criteria.









          

      

      

    

  

    
      
          
            
  
Pending Tasks

Misura™ is an heavily multi-threaded and multi-processing application, usually distributed between two computers (the client and the instrument itself).

It is important to have a clear visualization of what is happening and have a feedback about long-running tasks. When it is possible, the user should also have the choice to interrupt a task.

The Pending Tasks component is divided in three tasks tabs, each visualizing the ongoing operations on the Remote machine (the instrument), on the Local computer (the client) or data transfers involved in Storage synchornization.

A task is represented as a label containing the task name and a progress bar showing its current status.

Tasks can involve sub-tasks, which are displayed as rows below the main task.

The Pending Tasks component is usually hidden, and can be showed only from the Help menu. When a Remote, Local or Storage task is started, it pops up either in the form of a dialog or integrated into the Live Acquisition window.
When no more tasks are running anymore, the Pending Tasks component usually hides itself.


Remote operations

Remote operations, or tasks, run on the instrument hardware and involve electronics configuration, motor positioning, multi-processing initialization or termination, output file creation or closure, calibration procedures and much more.

The unique feature of Head Morphing, which allows to change the observing system as a function of the kind of measurement you want to make, implies a reconfiguration step which can take few minutes and involve many moving parts. All concurrent remote operations involved in this transformation are showed each time you connect for the first time to a Measurement App or each time you select a different Measurement App.

Starting and stopping a test involve the coordination of multiple processes, the creation of complex data structures and the writing of big chunks of data on disk. These remote operations appear when a new test starts and even more when it finishes.

The Remote tasks tab is empty when no remote tasks are running. It populates with a list of ongoing tasks when as the server performs them.

Remote tasks cannot be interrupted. You should not interact with the software in any way while remote tasks are running. If remote operations are forcefully interrupted or the user unintentionally interacts with the system while performing remote tasks, it is advisable to Soft-Restart the server.


Hint

It is safe to interrupt the test initialization for security reasons by clicking the Stop button in the Live Acquisition window. After that, anyway, it is advisable to run a new instrument initialization by clicking Initialize new test under the Measure menu.






Local operations

Tasks ran by the client application are listed in the Local tab. For example:



	Connecting to an instrument or opening an output file


	Drawing the user interface for the various components (cameras, thermal cycle, graphs, etc)


	Accessing to datasets







Local operations are generated both when connected to a remote server and when accessing to local output data files.




Storage synchronization

The default user’s Database Indexes is always kept synchronized with each instrument the client connects to. This allows to build an unified archive of all tests, independently from where they are carried out.

The position of the database on the client machine can be configured in the Preferences dialog, under Default database option. If you change this path without actually moving the database folder from the old location to the new one, the storage synch mechanism will re-download any available output file on the remote machine. You might loose old tests.

If the client is connected to the instrument when the a test finishes, the test is automatically downloaded to the local database. If the client was not connected, or other errors occurred, the next time you connect to the machine you will be warned about output files which were not downloaded.

The warning appears in the Pending Tasks dialog, under the Storage tab. The Storage widget allows manual management of storage synchronization. It is composed by four  sub-tabs containing tables, each table listing metadata about tests which can either be downloaded or ignored.

The workflow of a test which was not automatically downloaded is the following:



	It appears as row in Waiting approval table. You should right-click on the table and select Download from the context menu.


	This will move the row to the Download Queue table. After a while the download will start.


	Before the download starts you can still choose to Ignore the file by right-clicking on its row in the table and selecting Ignore. This will move the file to the Ignored table. Suppose you do not choose to Ignore it.


	The file download will cause a progress bar to appear in the Local operations, until downloads finishes.


	If an error occurs, the row will be moved from Download Queue to the Errors table.


	From the Errors table you can right-click again on the row representing the remote file and ask for a Retry.


	If you are unable to download a file, you can copy the full error log from the Errors table and send to the developers for debug.


	Once the file is correctly downloaded, its associated metadata row will disappear from the tables. A new entry will be added to the local Database Indexes.








Waiting approval

This table lists tests which are available on the machine but not on the local database.

By right clicking on one or more rows you can either:



	Download: Try to download the test by moving it to the Download Queue.


	Ignore: Discard the test by moving it to the Ignored table.










Download Queue

This table lists tests which are waiting to be downloaded.

By right-clicking on one or more rows you can Ignore the file by removing it from the queue and adding to the Ignored table.




Ignored

This table lists tests for which a download will not be tried again and for which the user will never be warned about.

By right-clicking on one or more rows you can Download the file again by moving its entry to the Download Queue.




Errors

This table lists tests which were not possible to download due to errors, along with a log message about the error which occurred. By right-clicking on one or more rows you can either:



	Retry the download it by sending back to the Download Queue.


	Ignore it by moving to the Ignored table.















          

      

      

    

  

    
      
          
            
  
Thermal Cycle Designer

The Thermal Cycle Designer contains the controls to setup the desired thermal cycle.

It is divided in three parts:


	The upper area contains a table where you can define the thermal cycle.


	The middle area shows general control options and furnace positions before the start or after the end of the test (if the furnace is motorized).


	The lower area is usually hidden and can be toggled via Plot button above the table. Displays a plot of temperature (red) and heating rate (blue) against forecasted time.




[image: ../_images/thermal_cycle.png]

Editing the thermal cycle table

To set a thermal cycle, fill the upper table with rows. Each row of this table represents a target status to be reached by the furnace as the test execution proceeds,
and how that status should be reached by the temperature controller.

Each row will be executed in sequence. When there are no more rows left, the thermal cycle ends,
which can cause also the end of the tests depending on how control options are configured.

You can load a predefined thermal cycle from the upper-right combo box, showing all saved cycles.

The table has four columns:


	Time: the expected end time of the row, relative to the start of the test (zero).


	Temperature: the target setpoint of the row, which the furnace controller will try to reach by modulating power emission.


	Heating Rate: the rate by which the temperature is changed from the previous row up (or down to) to the target setpoint.


	Duration: the expected duration needed to finish the row.




To insert or delete rows you can use the Edit menu or the context menu appearing by right-clicking on the table.
On insert, a new row will be added after the currently selected row. On Remove current line, the current row will be removed from the table.
On insert/delete/edit of a row, all subsequent rows might get automatically updated to reflect the changes (eg: in Time column).

The File menu allows to import/export from CSV (comma separed values) text files and to completely clear the table.

The Templates menu lists some shortcuts to easily create predefined thermal cycle based on few parameters.

Each time a row is edited or a cycle is loaded, its value is validated against temperature and heating rate limits, and the whole table is updated with valid data.


Hint

The time-temperature curve obtained by filling this table is not the real temperature profile that you will get at the end of the test. This is due to thermal inertia of the furnace, power emission limits, automatic control adjustments and variable length events.




Security limits

Thermal cycle designer will forbid the creation of temperature ramps which are considered dangerous for the equipment.
In particular, both heating rate and temperature columns are limited to maximum values determined in the factory.






Managing your thermal cycle definitions

Thermal cycle definitions can be saved on the instrument and easily recalled from a list. Before proceeding in describing how this works,
we should understand that in any given moment 3 thermal cycle definitions exists.


	The active thermal cycle definition will be actually executed by the instrument.


	Multiple definitions can be saved with names. A definition can then be loaded from the selected name. Once loaded, it will also be the active definition.


	That same definition is also displayed in the table. The user can then edit it. While he is editing, the displayed definition can diverge from the preset from which it was loaded. The user can then apply the displayed configuration - making it also active, and/or save it with a name.




These distinctions allows the maximum freedom of editing without compromising saved values or without undergoing automatic consistency and security checks from the instrument.
Misura™4 will warn the user if there is any unsaved or non-applied change, by coloring related controls in red.


	Read: Read the thermal cycle currently active on the instrument. If the thermal cycle on the instrument is different than what contained in the table, this button’s text would be red.


	Apply: Transmit the thermal cycle defined in the table to the instrument. If the remote cycle is different than the displayed one, this button will be red.


	Preset chooser: This combobox lists the definitions which were previously saved on the instrument. Select any entry to load the associated cycle on the instrument and in the table. It is colored red if the displayed/applied cycle differs from the visible preset name.


	Preset menu: This dropdown menu contains actions for managing saved definitions.


	Plot: Hide/show the thermal cycle plot.




At the end of the preset chooser listing there is a special entry,  +Add, which allows
to save the currently edited cycle with a different name. An input dialog will appear where you can set your cycle name.

The preset menu contains the following options:


	Save: Save the definition displayed on the table onto the remote instrument, with the name displayed in the preset chooser. If no name is displayed, a dialog will ask for a new name.


	Save as: Save the table’s definition onto a remote definition with a new name.


	Rename: Rename currently viewed definition name with a new definition.


	Delete: Delete currently viewed definition.







Inserting a Temperature Ramp (Point)

A temperature ramp is defined by a setpoint temperature and a time by which that temperature must be reached by the furnace (a time, temperature point). Before you input the target temperature, you should input either the end time of the ramp (Time column), or the desired Heating Rate, or the Duration of the ramp.

After having defined one of the three columns, you can input the Temperature target for that row. The remaining columns will be filled accordingly.

The default way of defining the ramp is by setting the Heating Rate column (°C per minute). The row Time and Duration will be auto-filled.

Filling the Duration column is mostly useful to express dwell ramps, where the heating rate is zero and the temperature must be kept fixed for a certain duration.


	To add a temperature ramp to the table:

	
	Right click on the row before the position where you want the new row to appear and select Insert point.


	Once the row appears, double-click either on the Heating Rate, Duration or Time cell and set the correct value.


	Double-click on the Temperature cell and insert the target setpoint.


	Other cells will be automatically calculated.


	Subsequent rows in the table will be re-calculated as needed.









Hint

Use negative values to express controlled cooling.






Inserting a Checkpoint

When a checkpoint row is reached, the setpoint will be kept constant until the real furnace temperature reaches it within a tolerance, or a timeout expires.

As the real temperature reached by the furnace is never exactly equal to the setpoint temperature, the checkpoint event allows to wait until the setpoint is actually reached before proceeding with the next row.

This is useful, for example, to start the controlled cooling always from the same temperature.

The setpoint will be the last available in the thermal cycle - usually the previous row in the table.

The typical temperature profile will be the same as a dwell row.

To add a checkpoint, right click and select Insert checkpoint. A dialog will show up, where you’ll be able insert the desired temperature and timeout.

The plot displayes checkpoints as dwell segments with few minutes duration, but their real duration cannot be forecasted because it depends from tolerance, timeout and furnace inertia.


Tip

A checkpoint with tolerance 3°C and timeout 60min is added after a row with setpoint temperature at 1000°C.

When the execution reaches the checkpoint event, suppose the real temperature is 980°C. The checkpoint will cause the controller to keep the setpoint fixed at 1000°C, until the temperature raises above 997°C (1000°C - 3°C tolerance). If this condition is not satisfied in 60min timeout, the control will anyway pass to the next row.






Inserting a Furnace Movement

Furnace movement events are available only if your instrument has a motorized furnace.

Movement events will cause the furnace to reach the configured position when executed. After movement execution, the control will pass to the next row.

During Open movements the thermal control will suspend and power emission will be zero until the movement ends.

During Close event, if the furnace thermocouple is controlling the temperature, the controller will try to keep any previously configured setpoint until the movement ends.

Furnace movement can be used to obtain flash heating / flash cooling temperature profiles.

To add a movement, right click on the previous row and select Insert movement. A dialog will show up, and you’ll be able to select a Open or Close furnace movement.


Hint

If the furnace is already in the position configured in the event, nothing will happen.






Inserting a Natural Cooling

During natural cooling events the thermal control is suspended and power emission is set to zero. The event will end, and pass control to the next row, when a target temperature is reached or a timeout occurs.

The resulting temperature profile is a double exponential decay.

To add a natural cooling, right click on the previous row and select Insert natural cooling. A dialog will show up, where you can set target temperature and timeout.


Hint

Set timeout to a negative value to avoid a timeout to occur. This might lead to unlimited acquisition whenever the room temperature is above the target temperature of the event. The suggested minimum target temperature is 40°C.






Inserting a Thermocouple Control Transition

Thermocouple transition events can switch the control temperature between two thermocouples.

The control temperature is usually equal to the sample temperature for the whole duration of the test. This means that the controller will try to obtain equality between sample temperature and setpoint temperature.

Under some circumstances it is preferable to control the furnace temperature instead, meaning that the controller will emit power to obtain equality between furnace temperature and setpoint.

A typical usage is to pre-heat a motorized furnace while it is opened, in order to obtain a flash heating temperature profile.

To add a control transition, right click and select Insert control transition. A dialog will show up, and you’ll be able to select to which of the thermocouples move the control and how fast.


Tip

We want to pre-heat the furnace to 1000°C while it is opened, then close it over the sample to flash-heat it. Then, we need to continue the thermal cycle up to 1400°C.


	We should:

	
	Set the “Kiln position before start” in execution options to “Opened”.


	Insert a thermocouple control transition as the first line of the cycle. We need to pass the control to the furnace in order to pre-heat it.


	Insert the pre-heating ramp to 1000°C as usual.


	Insert a furnace movement event to close it.


	Insert a thermocouple control transition to transfer the control back to the sample thermocouple. This transition should not be instantaneous, because after the movement there will still be turbolence due to thermal inertia. Give the transition a 5°C/min speed.


	Insert the last ramp up to 1400°C as usual. This ramp will be executed while the sample thermocouple is controlling.











Hint

This event is meaningful only when your instrument supports more than one thermocouple (samples and/or furnace).






Parametric Templates

The Templates menu in the thermal cycle gives access to thermal cycle templates.
A template is a shortcut to create a complex thermal cycle based on few parameters: for that reason they are also called parametric templates.


Single ramp

Create single-point ramp from current temperature up to end temperature, with specified heating rate.

Parameters:


	Ramp end temperature


	Heating rate




Example: up to 1000°C, at 10°C/min




Steps

Reach a start temperature with requested heating rate. Then, create a variable number of heat-wait segments.

Parameters:


	Heating Rate: used to reach the first step temperature and for subsequent increases.


	First step temperature: temperature at which stepping starts.


	Stasis duration: wait this time between heating steps.


	Number of steps


	Steps delta T: temperature increase for each heating step.




Example: up to 500°C, at 10°C/min. Than increase 20°C at 5°C/min and wait 8 minutes, for 7 times.

[image: ../_images/thermal_cycle_steps.png]



Maximize speed

Heat at the maximum supported heating rate up to the target temperature.

Parameters:


	Target temperature




Example: target temperature = 1600°C produces:

[image: ../_images/thermal_cycle_maxspeed.png]





Additional Control Options

Additional control options are displayed under the thermal cycle table. These can influence how the heating cycle and the test are stopped, plus initial and final furnace positions.


Stop after thermal cycle

The Stop after thermal cycle flag defines wether the acquisition should stop or not, when the thermal cycle reaches its end. If not, the acquisition will have to be stopped manually.

By clicking on the + button, two more sub-options are available. These are active only if the Stop after thermal cycle flag is checked, and are used to protract the acquisition further after thermal cycle end.


	Wait T smaller than: After the cycle is stopped, the test will be stopped as well only when the temperature is smaller than the configured value. Leave zero to disable this behaviour.


	Wait minutes: After the cycle is stopped, the test will be stopped as well after a certain amount of additional minutes. Leave zero to disable this behaviour.







Maximum test duration

This option will interrupt the test when the total duration reaches the configured valued. The thermal cycle will be implicitly interrupted.

This option will not force the test to have this duration: the test can end before this target duration if any other termination condition is met (end of thermal cycle, error condition, analytical condition).

Leave zero to disable.




Kiln position before start/after end

These two options allow to set a position of the furnace before and after the test. These options can be set either on Closed, Opened or Unchanged.

The movement needed to comply with this position will not be recorded in the test result.

The position before start is usually Closed, to avoid forgetting the furnace open. It can be set to Opened in case we need to pre-heat the furnace and then close on the sample. It should be avoided to set on Unchanged.

The position after end is usually Unchanged or Closed, to reduce thermal shock on the heating elements. It can be Opened to minimize the risk of sample flowing on the furnace or to quickly cool it for the next test.


Hint

Available only for instruments with motorized furnaces.











          

      

      

    

  

    
      
          
            
  
Data Plot

The data plot is a simplifyied plotting sub-window displayed in Live Acquisition and Misura™ Browser.

To access the visualization’s tweaks, you can right click on an element of the plot to get its options menu:



	Axis allows you to change what axis measures are plotted towards. You can join axes together in order to synchronize their scales.


	Curves allows you to select which curves to plot.


	View allows you to select if you want data to be plotted by temperature or by time.


	Reset rebuilds the data plot


	Update forces a reload of data.


	Properties allows you to set behavioural features of the clicked element


	Formatting allows you to set appearance features of the clicked element


	Zoom changes the zoom level


	Preious / Next Page changes the currently visualized page.


	Full Screen toggles fullscreen mode.


	Updates allows you to change the update frequency of th page.


	Antialias toggles antialias


	Export allows you to export the current page to a pdf







Other visualization, plotting and elaboration options are accesible via the Misura™ Navigator.





          

      

      

    

  

    
      
          
            
  
Camera controller

The camera controller is showed by any Live Acquisition App for controlling an instrument which is using cameras. When initially started, it appears as a live acquisition sub-window containing a dark gray rectangle over a light gray area, the former representing the camera resolution or CCD.

The principal mode of interaction with the camera is by right-clicking anywhere. The camera menu appears showing all possible controls.

If X or Y motors are defined for the camera, motion control sliders are shown near the sides of the window.


Hint


	Heating Microscope HSM has 1 or 2 cameras


	Vertical Optical Dilatometer and Horizontal Optical Dilatometer have 2 cameras


	Relative Fleximeter has 1 camera


	Absolute Fleximeter has 3 cameras


	Furnace test instrument has no camera







Streaming

Streaming can be started/stopped from the camera menu by setting the Streaming flag (first menu entry). Streaming means the user interface is continuously receiving and showing images. After a few seconds from when it is started, frames will be displayed in the gray area. If the streaming is subsequently stopped, the last frame will remain visible.

Streaming images will not interfere with a running test. It can be started, stopped and resumed without any effect on actual image analysis and acquired data.

The image viewed in the controller can be quickly zoomed in/out by using the mouse wheel. The Fit view action, accessible from the context menu, will resize back the image so it fits the window.


Saving the current frame

The current frame can be saved with Save frame camera menu entry. The first frame you save you will be asked a destination directory where to save current and all future frames.

That directory will be remembered for each time you click on Save frame and frames will be saved there with increasing sequence numbers.

All samples contained in the frame will be saved in separate images having the same sequence numbers.

File names will have the format  <name>_smp<N>_<seq>.jpg where <seq> is the sequence number increased each time you save, <N> is the sample number, <name> is the camera name. For example: Left_smp0_12.




Simulation

The Analysis flag activates image analysis on the received frames. This flag can be changed only when no test is running.

Simulation can be used before starting a real test, in order to validate the image quality.
For example, to check that sample borders and limits are correctly detected, or that motors react in the right way to sample movements.






Imaging

Most important digital imaging options are displayed in the camera menu, submenu Imaging, as a slider with an associated spinbox. You can either control the slider position or write the desired number in the spinbox and press Enter.

Available imaging options:


	Exposure (should be in range 1-1000)


	Contrast


	Brightness


	Gamma (should be minimum possible)


	Saturation (should be minimum)


	Hue (should be minimum)





Hint

On most models it is advisable to use the spin-box to control the exposure. High values (>1000) might freeze the camera.






Motion Control

Camera position can be controlled by up to four motors roles, depending on your instrument’s hardware:


	X, lateral


	Y, vertical


	Angle, angular


	Focus, focus distance, usually shared by (and affecting) all cameras




If those motors are available, their movement can be set from the camera menu, submenu Motion.

Each motor role shows an additional submenu called after its name, with those entries:


	A slider, to control the position.


	A Zoom checkbox, allowing to zoom in or out from the motion range for fine movements.


	An Is moving? flag: can be unset to block the motor (but cannot be set).


	A Set zero position action: define any current motor position as the new zero.


	A Configure motor action: opens the extended configuration panel for the motor.


	A Configure encoder action: opens the motion-to-image optical encoder configuration panel.




Moreover, X and Y motors are represented directly in the camera controller as a bottom slider (X) and a lateral slider on the left (Y). A right click on these sliders opens a context menu showing the current position and offering a Configure action to open motor configuration panel.

The motion sliders allow to focus-in by double-clicking anywhere on them.

There is a third way to interact with camera positioning: the motion handle. It is displayed as a red square in the top-left corner of the image. Dragging and dropping it around the image will cause a motion such that the new position of the top-left corner of the image will correspond to the position where you dropped the square.


Finding the sample on camera

Upon instrument initialization cameras should automatically be positioned very near to the sample. As Misura instrument allow Free Sample Positioning, motion control must then be used to exactly find the sample or the part of it which should be analyzed (eg: the border).

This positioning can usually be carried out with provided X, Y motion controls (were present) or with manual micrometrical axis tables.




Adjusting the focus

All Misura ODP instruments allow Free Sample Positioning. Before starting a test, the user must manually adjust the focus distance with the provided focus motion controller.

As the focus motor is only one and affects all cameras in the instrument, its motion control is usually showed in a priviledged position as a slider on the bottom of the acquisition window.

In case multiple cameras are used (horizontal dilatometer or fleximeter), care must be taken at positioning the sample perpendicularly to the alumina holding rods, in order to have the same focus distance for all of the cameras.

Focusing the sample is an iterative procedure, where the focus slider is moved back and forth until the optimal focus distance is found.






Morphometrics

The Morphometrics submenu allows to visualize some of the results obtained from image analysis.
The results will be displayed as lines overlaid on the original frames.

The most useful analysis overlay is the Region of Interest, which can be activated by the View Regions action.
Each sample defined for the camera will be surrounded by a colored rectangle, representing the area of analysis.
This rectangle can be resized by dragging and dropping two hook points on the top-left and bottom-right corners.

Restricting the region of interest allows to individually select samples when more than one is viewed by the same camera. It is also useful to filter out imperfections, like dirt on holding plate or camera CCD.

The Reset Regions action will restore the default region sizes.

Then we have ovalyays, which are realtime visualization of some aspects of the analysis being performed.

Generic overlays:


	Grids: this overlay will draw a grid over each sample.


	Profile: the border detected as the sample will be overlaid by a blue line, and the area of the sample with a faded blue.


	Values Label: a movable label is added. The label will contain lines in the form name: value, where name stays for any sample option and value shows the current value for that option (e.g.: height).


	Pixel Calibration: the Pixel calibration tool discussed below.




Heating Microscope HSM overlays:


	Points: relevant profile point are highlighted with circles.


	Base and Height: (only for Heating Microscope HSM) two perpendicular segments starting from the bottom-left starting point of the sample, representing base and height.


	Circle Fitting: (only for Heating Microscope HSM) a circle representing the best circular fitting to the profile.




Horizontal Optical Dilatometer, Vertical Optical Dilatometer, Absolute Optical Fleximeter overlays:


	Reference line: position of the sample border at the beginning of the test.


	Regression line: actual detected position of the sample border.


	Filtered profile: profile fragments which were actually included in the calcuation of the regression line, after noise filtering.





Samples

The concept of sample is fundamental to understand the camera controller, the management of ROI and the image analysis. From the point of view of the camera, a sample is a portion of image, delimited by a ROI, which can be analyzed in some way to extract results. This not always correspond to the concept of physical sample known to the instrument’s operator.

For example, a sample is a cylinder of pressed powder used for Heating Microscope HSM analysis. In this case, the sample known to the camera is the same physical sample intended by the operator.

The situation is less intuitive in the case of dilatometers or fleximeters. In this case, the operator places one physical sample, but two (or more) cameras view just one side of it. Each side is viewed as a separate sub-sample, one assigned to each camera.

The samples are defined in the active instrument. The camera just points to them, and use them to analyze images and associate output results.

A camera can view one or more samples at the same time. The number of defined samples is available under the Number of samples option in the camera configuration panel. The camera defines an equivalent number of sub-options, accessible by clicking on the right + button, each pointing to the sample which should be used for the corresponding sample number.

Each sample defines its own image analyzer configuration. The advanced user can thus fine-tune image analysis parameters for each sample in the image, separately, making simultaneous multi-standard analysis straight-forward.

Active samples are shown in the camera menu, as Sample <N> menu items where <N> is the sample index from 0 (first sample) to the number of samples minus one.

Each sub-menu contains these items:


	Configure: opens the sample configuration panel, where image analysis results are stored.
From the object tree on the left, it is possible to access to the image analysis option. Some true/false flags are repeated as menu items.


	Balck/white levelling: convert the grayscale image to black/white. Color levels are accessible from the image analysis configuration panel.


	Adaptive threshold: convert grayscale image to black/white.
Color levels are adaptively calculated point-by-point as a function of neighborhood intensities.


	Dynamic regions: activate ROI auto-follow.









Advanced configurations

The complete camera configuration panel is reserved for service purposes.


Pixel calibration

A visual tool to calibrate the translation between CCD pixels and real sample’s microns. Reserved for service purposes.




Troubleshooting

To forcefully restart a camera which is no longer working correctly follow these steps:


	Open a camera controller, either from an instrument using it or from the global configuration panel.


	Right click on the camera frame. Select Configure action.


	Locate the Running acquisition option and set its value to Stopped.


	Back to the controller. Ensure the camera is Streaming by activating the corresponding context menu option.


	The camera will try to restart itself. On repeated failures, Soft-Restart the server. On continued failure, Rebooting the embedded controller.












          

      

      

    

  

    
      
          
            
  
Misura™ Navigator

Misura™ Navigator is a tree view, located on the right of the application by default.

It contains all the currently loaded datasets, and it’s an entry point for data manipulation.
When you right click on a curve or group of curves, you get a menu that lists all the possible operations you can perform on that curve.





          

      

      

    

  

    
      
          
            
  
Metadata and Scripts

Misura™ identifies and records charactersitic points during the analysis into Metadata options, containing the values of time and temperature at which the point was recognized.

Example of metadata are:



	Microscope Samples characteristic shapes, like Sintering, Softening, Sphere, HalfSphere, Melting.


	General Measurement points of interest, like where the maximum temperature is reached, the maximum heating or cooling rate, when did the cooling phase started, etc







The identification logic is expressed by means of Script options, containing small portion of source code. The editing of Scripts is currently reserved for service purposes.












          

      

      

    

  

    
      
          
            
  
Preferences

From preferences dialog you can tweak Misura™ user interface (or client-side) configuration.
They are related to the computer running a Misura™ client and will not be saved on any instrument.

The first entry, ConfigurationFile, is the location where Misura™ stores its configutaion’s details.

Everytime you change something, you should press Save to ensure that all changes have been saved.

The Reload button allows you to reload the configuration if, for example, something went wrong after a change.

Open button shows a dialog to locate and load another existing configuration.

[image: ../_images/preferences.png]

Main Tab

The Main tab contains general configuration options.


	Client Language allows to select the interface language


	Remote Server Refresh Rate (ms) lets you change the frequency, in milliseconds,
of data update from server, if you are connected to a server (in an offline environment, you can ignore this option)


	Default Database is the location of the default tests database (see Database Indexes)


	Auto-download finished tests: when connected to a server, this option defines if a test should be downloaded locally or not when it finishes.


	Recent Servers is the number of recent servers to be remembered


	Save User/Password bu Default defines if, when connecting to a server, the password should be saved or not


	Recent Database Files: the number of databases to remember in the list of last used databases


	Recent Test Files: the number of tests to remember in the list of last opened tests


	Recent Misura3 Databases: the number of Misura™ 3 databases to remember in the list of last opened Misura™ 3 databases


	Log files directory: the location to place log files


	Logging level: from 0 to 50, defines the amount of logging (0 -> notheng, 50 -> everything)


	Size of each log file: the size of a log file, after which, the log file is archived


	Max number og logfiles to be kept: when the number of log files exeeds this number, the oldest log file is deleted


	Measurement units: a table that defines, for every Misura™ dataset, its unit







Misura 3 Tab

This tab contains only the Enable Misura 3 database interface flag, that enables/disables Misura™ capabilities to import Misura™ 3 databases.







          

      

      

    

  

    
      
          
            
  
Measurement Apps

Misura™ software can run different measurement functions, depending on its version and on your hardware capabilities.
Each measurement is controlled by a specific App which allows the user to access relevant configuration options,
frame the samples on cameras, start/stop the test and follow the analysis real-time.

Measurement Apps are accessible through the Live Acquisition executable.

Use this index to navigate to the desired measurement function.


Hint

Availability of measurement functions depends on your hardware and software version.





	Heating Microscope HSM
	Quick Start: Running an Heating Microscope Test

	Sample preparation for the Heating Microscope

	Quick Start: Browsing a Microscope file

	Viscosity

	Surface Tension with the Sessile Drop method





	Horizontal Optical Dilatometer
	Quick Start: Running an Horizontal Dilatometer Test

	Sample preparation for the Horizontal Optical Dilatometer

	Quick Start: Browsing an Horizontal Dilatometer file





	Vertical Optical Dilatometer
	Quick Start: Running a Vertical Dilatometer test

	Sample preparation for the Vertical Optical Dilatometer

	Quick Start: Browsing a Vertical Dilatometer file





	Absolute Optical Fleximeter
	Quick Start: Running an Absolute Optical Fleximeter Test

	Sample preparation for the Absolute Optical Fleximeter

	Quick Start: Browsing an Absolute Fleximeter file













          

      

      

    

  

    
      
          
            
  
Heating Microscope HSM

The Misura Heating Microscope allows to study the change in shape of a small sample of material as a function of the furnace temperature.
Through Misura Morphometrics analysis, it is possible to fully characterize the behavior of the material,
automatically detecting characteristic shapes according to improved mathematical models and traditional international standards as well.

The following sections contain instruction about how to start a test, prepare a sample and analyze test results.



	Quick Start: Running an Heating Microscope Test
	Microscope Acquisition Window

	Adjusting the camera position

	Recording Frames and Profiles

	Standards for Characteristic shapes identification

	Stopping the test when a shape is recognized





	Sample preparation for the Heating Microscope
	How a good sample looks like

	How a bad sample looks like





	Quick Start: Browsing a Microscope file
	Opening the output file

	Test Configuration and Data

	Visual shape assessment

	Interacting with the Data Plot

	Creating a Report

	Exporting to a Video





	Viscosity
	Calling the viscosity plugin

	Choosing the known temperature points





	Surface Tension with the Sessile Drop method
	Activating the Sessile Drop

	The Surface Tension plugin













          

      

      

    

  

    
      
          
            
  
Quick Start: Running an Heating Microscope Test

While the general Live Acquisition instructions apply also for the Heating Microscope, this section describes specific topics which should be considered to carry out microscopy tests.


Microscope Acquisition Window

The Microscope Live Acquisition window additionally comprises:



	One/two high-resolution Camera controller windows with height motion controller.


	Global Focus motion controller.


	Samples height information displayed on the Status panel panel, updated realtime during the analysis.


	One to eight Samples tabs in the left Test Configuration area.


	The Storyboard bottom area.







The workflow for a microscope test follows the general rules described in section Live Acquisition.




Adjusting the camera position

ODP cameras are mounted on two motorized axes: the height and the focus. Older/simpler models might still have manual positioning with micrometric translation stages.

The initial position of the camera should be automatically reached during instrument initialization, as described in Motion Control.

Use the height motion control to ensure the holding plate is always visible.

Once the position of the camera has been established you have to put the sample in focus.  This should be carried out before every test.  Note that the typical cylindrical shape of the sample means that when the centre of the sample is in focus the sides are not.  This is absolutely normal and does not affect the reliability of the analysis which will get the best results anyway.

The Region Of Interest should then be reduced so that the height of the sample occupies just 3/4 of the active region, and the width is 1/2. If multi-sampling, each region should manually be placed around each sample.
The excess of the region dimensions with respect to the sample depend on the limiting sample behaviours. If the melting should be observed, enough region width should be provided for the molten sample to be still framed. If the sample undergoes a huge expansion, the region height should exceed the initial sample width by appropriate amount.




Recording Frames and Profiles

Misura™ records can record raw frames, as they are received from the camera, and/or analyzed (x,y) profiles produced by the morphometric analysis.

The default behaviour is to record profiles and discard frames, to save space.

This option can be set in Samples sections independently for each sample.




Standards for Characteristic shapes identification

Characteristic shapes are displayed in the Samples tab in Test Configuration side area, as a Time/Temperature Metadata and Scripts label.

Basic shape recognition parameters can be affected by expanding sub-options ([+] button on the right) and adjusting the sliders to the desired values.

Misura™ always calculate shapes according to its advanced morphometric logic, making use of 3D extrapolations and




Stopping the test when a shape is recognized

A Microscope test can be automatically interrupted when a characteristic shape is recognized. To activate this termination option:



	Select the Measure tab in Test Configuration side area and scroll to the bottom of the page.


	Locate the After recognized shape option and click on the checkbox on the right to enable it.


	The the test will end when the Melting shape is recognized.







To fine-tune the test termination, expand sub-options by clicking on the “+” sign on the right of the Edit button.



	Stop after temperature changed by will cause the test to interrupt after the temperature changed by the configured number of degrees from the instant when the shape was recognized. The default value is 10°C. This means that if the melting is recognized at 600°C, the test will be interrupted at 610°C, or 590°C in the unlikely event the furnace was cooling down.


	Stop after time passed will wait the configured amount of seconds before interrupting the test. The default value is zero, meaning as soon as the condition is met.


	The test will end when both termination options are met (after temperature changed enough and after the minimum amount of time has passed).


	Require all samples: in case of multi-sample tests, the default behaviour is to interrupt the test as soon as any sample meets the conditions (as soon as any sample melts). If this option is activated, all samples are required to meet the termination conditions for the test to be stopped (all samples must melt).













          

      

      

    

  

    
      
          
            
  
Sample preparation for the Heating Microscope

The shape of the sample and the change in outline are very important for recognizing the fundamental points. The sample should be made with the correct tools and be of the correct dimensions.  You should also avoid carrying out tests on samples with particular imperfections, such as those described and illustrated below.

The preparation of a test consists of a series of manual procedures by which you make a test sample, put it in the kiln, focus the image and make the initial observation of the silhouette (to avoid acquiring unreliable data).

The rectangular base and the pressing tool are designed for preparing a sample of the correct dimensions, where the diameter of the base of the cylinder is 2/3 of the height.  Keeping these proportions is very important as the analysis of the images works on the basis of this relationship.  The best dimension is 2mm in diameter by 3mm in height.  To make a sample you should put a small amount of body on the metal part of the base, beside the holes.


	The powder should be dampened with water (distilled if possible), to form a composite which is cohesive enough to ensure compactness, without sticking.  The material should be dampened just enough for it to hold its shape. If it is too dry it will break when it is being transferred to the plate.  If it is too wet it could mist the quartz filter at the edge of the kiln at temperatures between 70 - 120°C.


	Using this compound fill one of the holes up to the edge and press down using the pressing tool.


	Add more compound little by little pressing it down between each addition so that you get a compact cylinder.


	Put a small amount of dry powder on the surface of the sample so that it does not become stuck to the pressing tool when you transfer it to the plate.


	When you have made the cylinder you need to “slide” the base open a little so that the sample is free to be pushed onto the plate, which you should place underneath the hole.


	Gently push the sample with the pressing tool until it the sample comes out and stands upright on the plate.  It may help to turn the pressing tool slightly while doing this.


	Repeat the procedure on the same plate if you want to do a double test.




If the sample has been correctly prepared and placed, besides obtaining error free analyses, you can also better recognise the characteristic points of the test.  Above all, to record the point of fusion, it is essential that the sample is made correctly.


How a good sample looks like

The correct preparation of the sample is essential to a good analysis. Based on our experience, we found that the best shape for ceramic materials the diameter of the base of the sample should be 2/3 of the height. This relationship is the standard for this type of study.  Variations from this standard may cause erroneous results.


	The base should appear as a single line.  You should not be able to see the rear part of the base.


	There should be no light between the base of the sample and the plate.  This is essential for an accurate calculation of the angle of contact and the outline of the sample.


	Both the sides and the top of the sample should have the natural roughness which results from making the sample without compressing it or dampening too much.  If the sample is too damp you might get unreliable results because the consistency of the sample is not correct.


	The sample should touch the plate all round without leaving any spaces or excess deposits around the edges. It should be at an angle of 90° to the plate.


	Make sure the plate is perfectly clean and that there are no residues or build up of body on it.


	In general it is best to place the samples in the centre of the plate, slightly towards the thermocouple.




[image: ../_images/good.jpg]
Multi-samples should be separated sufficiently so that they will not stick together or melt over the edge of the plate damaging the thermocouple.  For safety you can put another plate underneath.
They should be positioned so that the do not melt together and confuse the analysis of the image but not so far apart that they could melt over the edge or not be picked up properly by the camera.




How a bad sample looks like

A gallery of bad sample positioning. The advanced image analysis and morphometrics algorithm of Misura will do their best at getting resonable numbers out of these images. But, it the user chooses to carry out the analysis under International Standard metrics, the results will be misleading or completely wrong.


Inclined sample

A sample of this kind may cause a wrong measurement of the height. In this case, the measurements are taken more on the diagonal of the sample than on the actual height even so the analysis indicates accurately little and predictable slopes on the top of the sample. In addition to this the sample has a beginning slope which increases during the heating, you could even have an apparent increase in height.

This image also show wrong base focus.

[image: ../_images/inclined.png]



Irregular sample top

As described in the previous situation, a sample that shows an unusual bulge on the top, as in the figure, can modify the measurement of the height. Moreover it can influence all the development of the analysis, if it melts so as to modify the profile of the fundamental shapes.

[image: ../_images/irregular_top.png]



Out of proportions

The sample prepared with the proper accessory is correctly proportioned to have the fundamental shapes during the firing cycle. If you do not pay attention to the proportion between height and width, already standard for these kind of instrumental measurements, the analysis will not be reliable. For a square sample, as it is shown in the upper figure, it will be difficult to recognize the right shapes at the right moment, in particular you can have problems with the sphere.

[image: ../_images/proportions.png]



Dirty base

You need to carry out a test with the base well cleaned around the sample, and you have to check it either before putting the sample in the kiln or by observing with the camera. The little quantities of material or in general the dirt on the base do not allow the measurement of the contact angle, whose measurement is only possible on a smooth and well cleaned base.

This images also shows a base with wrong focus and inclination.

[image: ../_images/dirty.png]



The “flying” sample

You should avoid carrying out tests with samples which, like that in the figure, do not lay uniformly on the base. The contact between sample and base should not have “light”; in this case you will have unreliable contact angles.

[image: ../_images/flying.png]








          

      

      

    

  

    
      
          
            
  
Quick Start: Browsing a Microscope file

This Demo will guide you through the data analysis of Heating Microscope (hsm) output files.

In order to follow the tutorial you should:



	Download and Install Misura™ (see Installation).


	Get the sample file Microscope Sample File 1.h5 [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20File%201.h5] and save it to a known location (eg: your Desktop)








Opening the output file


	Run browser.exe application from the folder where you extracted Misura™, or run the link you created on your desktop.


	In the Recent data sources window, under the first column Recent files, click on Add button.


	Browse to the location where you downloaded Microscope Sample File 1.h5 [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20File%201.h5], select and open it.


	The loading process will start. If the file is considerably big (several GB) or located on network or slow storage drive, it may take several seconds to open.


	The file is displayed on a new tab, on the right of the Databases tab.




The test file tab is divided in three areas:


	A menu bar in the upper part of the window


	A right area called Test Configuration. It is divided in at least 4 vertical tabs: Measure, Thermal Cycle, Sample0 and Results.


	A central area displaying movable and resizable sub-windows, where you see the Data Plot window.







Test Configuration and Data

The most relevant configuration options used for the test run and output results are displayed in the right Test Configuration area.


Measure overview

The first Measure tab contains the list of options regarding the test run.

Detect the following:


	Name: Name of the test run, set by the operator anytime before the end of the test.


	Operator: the login name used by the operator who started the test.


	Elapsed time: the total duration of the test.





Measurement Units

Elapsed time is expressed, by default, in seconds unit. This might be difficult to read. You can change the measurement unit of any value listed in Misura™ options panels by following this steps:


	Right click on the Elapsed time text label. A menu will popup.


	Select the Units sub-menu.


	Change to your preferred unit. E.g.: minute.


	You can roll-back to second by repeating the procedure.





Hint

If the Units sub-menu is not shown, it means the option does not have a specific measurement unit set, so it cannot be converted.






Metadata

The following values (after Elapsed time) are called Metadata or, more specifically, characteristic points. For example:


	End of the test: it contains time and temperature values recorded when the test ended.


	Maximum temperature: time and temperature of the point when maximum temperature was reached.


	Maximum Heating Rate: time and temperature of the point when the maximum punctual heating rate was reached in the measured temperature profile.




By clicking on the last one, a new window will open displaying again time and temperature, plus a Value number. In the case of Maximum Heating Rate, this number is the actual heating rate (°C/s) measured in that point.


Hint

At the end of each Metadata row there is a + sign button. It means there are nested options under the visible one. By clicking on it, access to another option, viewed as a Edit button. By clicking on it, you open an editor where you can read the logic used to calculate the parent Metadata point.

General measurement Metadata are usually short and simple to understand.








Thermal cycle

This tab contains a table with points defining the thermal cycle and a graph with a cartesian representation.

The graph displays two curves: the red line is the setpoint temperature; the blue line is the heating rate.

If you cannot see the axes and their labels, enlarge the application window and the Test Configuration area.




Sample data

Most relevant data in the Sample0 tab are:


	Name: if set, the name the operator gave to this specific sample. It is mainly useful for multi-sample measurement.


	Initial sample dimension: the operator can optionally set this value if he measured the initial sample height with other instruments (eg: a digital micrometer).


	Record frames/profiles: did the operator required full frames and (x,y) sample profiles to be recorded onto the output file? In the case of Microscope Sample File 1.h5 [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20File%201.h5], only profiles were required, in order to keep the file smaller.




You can ignore Height, Perimeter, Volume options an all their nested options, as they are only useful during live acquisition.

Of paramount importance are the five Characteristic Points, expressed as Metadata options. They are defined and identified according to the highly reliable Misura™ standard.


	Sintering


	Softening


	Sphere


	HalfSphere


	Melting





Re-evaluating Standards

As the logic by which characteristic points are identified is accessible from the Misura™ Browser, you can also change it and see the effect on the identified points. This process is called Standard Re-Evaluation, as this logic is usually codified in an international standard depending on your material.

As an example, we will affect the Sintering point.


	Take not of the current value of Temp:/Time: label (611.0, 1805.0).


	Click on the [+] button right to the Temp:/Time: label.


	Change the Height shrinking for Sintering from 95 to 90.


	Locate the Measure menu on the upper-left menu bar. Click on the Re-evaluate standards action.


	Move your mouse on the Sintering label. It will update to a different Temp:/Time: point (621.0, 1836.3).




You required a higher shrinking in order to detect the Sintering point, so the point is now identified 10°C above its original value.






Results

The Results tab displays the Misura™ Navigator tree component. It is the tree of recorded datasets (curves), organized by groups. Each group represents a parts of the instrument or of the measurement.

For example:


	hsm represents the Microscope instruments itself. It generates no datasets, but contains one sample (sample0). If we have a multi-sample test, it will contain one sub group for each sample.


	kiln represents the furnace, and contains datasets regarding temperature control (T, temperature; S, setpoint; P, power; etc).




We will see it in detail in next sections, as it is the most powerful and versatile component of the interface.






Visual shape assessment

To understand the behaviour of your material with time and temperature change, you will use three main tools:


	The Story Board, where you can see the shape of your sample at the desired time in the test.


	The Navigator tree in Results tab contained in the Test Configuration area, where you can see the exact value of each calculated output.


	The Data Plot, where you can evaluate the behaviour and rate of change of each plotted datasets.




These tools are all synchronized at the same time in the test.
When you move the horizontal slider in the Snapshot area, the images are updated to reflect the state of the sample at the selected point.
At the same time, a vertical red bar updates its position on the Data Plot, and Navigator tree changes in order to display the current values at that point.

The point selection can happen either:


	by moving the Snapshot horizontal slider


	by clicking on the red bar in Data Plot and dragging in a new position


	by dragging the label showing the characteristic point value (eg: Sintering) and dropping it on the Story Board.
The Story Board and the plot will sync to the requested time.

[image: ../_images/story_board_and_plot_bar.gif]




The Story Board area also displays the temperature value associated to each image.
You can add more values by dragging them from the Navigator tree and dropping them in the Story Board area.
To remove unnecessary values, right click on them and de-select from the Labels popup sub-menu.


[image: ../_images/story_board_labels_length_steps.gif]



The legnth, number of rows and stepping of the storyboard can be changed from the context menu that can be called by right-clicking
on the horizontal scroll bar or by clicking on the (…) button on the right of the current sample name.


Characteristic points on the Data Plot

Characteritics points are connected to the behaviour of dimensional shape measurements as a function of temperature and time. It is thus interesting to evaluate their position on the plot.

The command to add characteristic points is located in the Navigator tree context menu, accessible by right clicking on tree elements.

As Navigator tree elements represent different parts of the measurement instrument (datasets, samples, instruments, devices, etc), the menu which pops-up depends on the kind of element.


	Click on a blank area inside x,y ranges of Data Plot graph. A blue dashed line will appear over the plot area, meaning you correctly selected the graph on which to draw.


	Go to the Results tab and look at the Navigator tree.


	Find the sample0 group, under hsm group (path is /hsm/sample0).


	Select and right click on /hsm/sample0 group.


	From the context menu, select Show characteristic points.


	A new dialog will open. Click Apply.


	If a new dialog opens with “You should run this tool on a graph”, check that you properly selected the graph area in point 1.




The five characteristic points labels will appear on the Volume curve (blue), near their intersection points. You can select the labels with a click and move them in order to increase readibility.




Changing a characteristic shape

To modify the value of the automatically calculated shape:


	Evaluate the frames on the Story Board and locate the frame which you wish to assign to a specific point.


	Click on the frame image and keep pressed to start a drag gesture.


	Drag & drop the frame image onto the target point’s label.




In the following example, the Sphere point was changed from 908°C to 888°C:

[image: ../_images/change_shape_from_browser.gif]





Interacting with the Data Plot

As you have seen for Characteristic Points, the Navigator tree is the gate to the most important actions you can perform on the data plot.

In order to plot one more dataset (for example the height):


	Right-click on the dataset you wish to plot on the Navigator tree (/hsm/sample0/h).


	Select the Plot action from the context menu.




The same apply for removing a dataset and all its related objects from the plot. The Plot action will be checked if the curve is visible, unchecked if not visibile.


Mathematical manipulations: Smoothing

A frequently used feature is the Smoothing of a dataset. In order to smooth the volume, for example:


	Locate the Vol (/hsm/sample0/Vol) element in the Navigator tree under Results tab.


	Right-click and select Smoothing.


	A dialog will appear. Click Apply.


	A new temporary label in the dialog confirms the dataset was created. Click Close.


	The Navigator tree is updated. The Vol element now has a child: Smooth(48,Vol). This is the smoothed Vol dataset.


	Plot the smoothed dataset using its context menu.




The new dataset will be plotted over the old one, with the same color and just slight differences (mostly visible in the first 200s or 50°C). You can either un-plot the old one, or change the color of one of the two.

To change the color of the curve:


	Click on the curve on the Data Plot.


	Right-click again on the same spot. A context menu opens. Choose Formatting.


	Select the second tab, with a Line symbol.


	Change the color to something distinguishable (eg: red).









Creating a Report

Sample reports summarize the most meaningful data about a test run and a single sample behaviour in a printable page.


	Identify the Navigator tree element for the sample you are about to create a report for. E.g.: /hsm/sample0.


	Right-click on the element and select Report. A new dialog opens: click Apply.


	A temporary label Done appears. Click Close.


	
	Reports are rendered as new pages in the Data Plot. Right-click anywhere in the Data Plot and select Next page.

	Wait some secons for the rendering of the report to complete.







	The Data Plot displays the report.


	Right-click anywhere in the Data Plot and select the Export action.


	Select the location of the output PDF file.




The exported report is vector quality. Compare your result with Microscope Sample Report 1.pdf [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20Report%201.pdf].


Creating a report listing all images

Listing all images, according to temperature and time steps, can be accomplished by the Export images action. It can be reached either:


	By right-clicking on the sample0 vertical tab title in the Test Configuration panel on the right.


	From the context-menu of sample0 node in the Navigator (right-click on the node).


	
	From the Storyboard, by right-clicking the slider or clicking on the … button on the extreme right.

	In this case, time/temperature stepping will be inherited from the current storyboard settings.









This action will output an HTML document listing all images, according to the selected starting/ending temperature and temperature/time stepping.

Compare your result with Microscope Sample Images 1.html [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20Images%201.html].






Exporting to a Video


	Identify the Navigator tree element for the sample you are about to create a report for. E.g.: /hsm/sample0.


	Right-click on the element and select Render video.


	On Microsoft Windows™, a native dialog will open asking the desired output video encoding. Choose according to your supported formats.


	You can click Cancel anytime without loosing the partially rendered video.




Compare your result with Microscope Sample Video 1.avi [https://bitbucket.org/tainstr/misura.client/downloads/Microscope%20Sample%20Video%201.avi].


Hint

Install Xvid [https://www.xvid.com/download/] MPEG4 video compression filter in order to get smaller video outputs.









          

      

      

    

  

    
      
          
            
  
Viscosity

The determination of the viscosity curve of glasses is performed using data supplied by the heating microscope and by a dilatometer.
This method is based on the Vogel-Fulcher-Tammann (VFT) equation.


\[log \eta = A + \frac{B}{ T - T_0 }\]

The determination of the parameters A, B and T0 is done using three pairs of known temperature-viscosity (η,T) values.

According to Scholze (1962) and Ferrari, Magrini and Brunetti (1980), in correspondence of some characteristic points of glasses,
it has been established that the viscosity values are fairly constant:


	Glass transition temperature: log η = 13 Poises


	Softening point (calculated with a mechanical dilatometer): log η = 10,25 Poises


	Sintering beginning: log η = 10 Poises


	Softening point (calculated with an optical dilatometer): log η = 8,2 Poises


	Sphere temperature: log η = 6,1 Poises


	Half sphere temperature: log η = 4.5  Poises





(1 Poise= 0.1 Pa * s)




These data allow to solve the equations system to determine A, B and T0.
Applying the VFT equation, the viscosity trend can be completely reconstructed,
right across the temperature range. This operation is completely automatic,
once inserted in the software three of the six temperatures mentioned above.


Calling the viscosity plugin

It is necessary to open the softening test of the material you are interested in the Misura™ Browser. Then:


	On the Misura™ Navigator, locate the sample<N> node corresponding to your sample (sample0 in single tests).


	Right-click on the node to access the context menu. Select viscosity entry.




The viscosity parameters window will open:

[image: ../_images/viscosity_parameters.png]
The Temperature dataset field refers to the temperature values which will be used to calculate the viscosity. It is pre-compiled and should not be modified.

Three temperature-known viscosity pairs are then listed. Each pair consists of a temperature, which should be manually added by the user, and a known viscosity point,
which should be selected from the drop-down menu. Each known viscosity value should be unique in this window.

The user can also insert a viscosity number, if none of listed viscosities is considered satisfactory for the analyzed material.

The order of viscosity points does not matter.

The Output dataset name comes precompiled and shows the name of the dataset where the viscosity data will be stored.
It is possible to run multiple viscosity calculations,
with different known point combinations, by giving them different output names (like viscosity_1, _2, etc).

After clicking on Apply button, a new viscosity dataset will be created as a sub-node of sample temperature. It can then be plotted and managed the usual way.

The viscosity parameters and outputs will be saved with the current plot.

The viscosity data are expressed as viscosity logarithm (log η), in Poises.

An example of viscosity curve obtained for a glass is provided below:

[image: ../_images/viscosity_curve.png]



Choosing the known temperature points

As mentioned above, Scholze proposed six values in correspondence of which the viscosity values can be considered fairly constant.

But if the three values chosen to calculate viscosity are too close each other, the viscosity curve cannot be calculated correctly.
For this reason, it is necessary to follow the procedures described below, and not to choose three random values among the six.

The choice of the three temperatures is fundamental in order to perform the viscosity calculation in a correct way.

Now it is necessary to distinguish two cases:



	your laboratory is equipped with Misura™4 Heating Microscope and Horizontal or Vertical Optical Dilatometer;


	your laboratory is equipped with Misura™4 Heating Microscope and a traditional mechanical dilatometer.








Microscope and Optical Dilatometer

In this case, the viscosity calculation is performed using data provided by the horizontal optical dilatometer and by the heating microscope.
The values employed correspond to the temperatures of glass transition (optical dilatometer), sintering beginning and half sphere (heating microscope).

A preliminary thermal expansion tests is performed with the optical non-contact dilatometer,
in order to obtain the expansion curve of the sample analyzed, identifying its glass transition temperature (the heating rate can be 20°C/min).

The second step consists of a softening test with the Misura™4 Heating Microscope,
in order to determine the two temperatures of “sintering beginning” and “half sphere”.

We identify manually the sintering beginning point in correspondence of the shrinkage onset,
as shown in the following graph. The half sphere temperature is automatically identified by the software.

[image: ../_images/viscosity_microscope.png]
Then, you should insert the values of glass transition (“Glass transition DIL”) obtained from the dilatometric test performed with MISURA ODLT,
sintering beginning (“Sintering beginning HSM”) and half sphere (“Half sphere HSM”), obtained with the heating microscope.




Microscope and Mechanical Dilatometer

You can measure viscosity using the data provided by a mechanical dilatometer.
In fact, you can use the temperatures of glass transition and dilatometric softening (from a mechanical dilatometer)
and half sphere (from heating microscope).

You should insert the two values of glass transition (“Glass transition DIL”) and dilatometric softening (“Softening point DIL MEC”),
obtained from the dilatometric test performed with a mechanical dilatometer.
The third value is the “half sphere” temperature, obtained with the heating microscope.









          

      

      

    

  

    
      
          
            
  
Surface Tension with the Sessile Drop method

Misura™4 MorphometriX can extrapolate the surface tension of the sample from its shape and some additional parameters about the material and the atmosphere.

The method relies on the numerical solution of the Young-Laplace equation for the surface tension of a sessile drop:


\[p_1 - p_2 = \gamma (\frac{1}{R_1} + \frac{1}{R_2})\]

Where:
* \(p_1\) is the pressure on the internal wall of the drop (material against atmosphere)
* \(p_2\) is the pressure on the external wall of the drop (atmosphere against material)
* \(\gamma\) is the surface tension
* \(R_1\) is the first curvature radius describing the upper-half of the drop
* \(R_2\) is the second curvature radius describing the upper-half of the drop

The analysis is split in two phases:


	During a normal Heating Microscope HSM test, adimensional shape parameters are calculated by solving the Young-Laplace equation for the sessile drop.


	Once the test is finished, it can be loaded in the Misura™ Browser to calculate the surface tension from the adimensional parameters. In this phase the user should provide additional material’s and environmental properties like density, thermal expansion, atmosphere etc.




This design allows the user to change/correct any material property without the need to re-run the entire analysis.


Activating the Sessile Drop

Sessile drop analysis can be activated in each sample’s Analyzer configuration panel, by setting to True the Enable sessile drop analysis (default=`False`) option.
Alternatively, from the Samples submenu in Camera controller windows, you can directly turn this option on or off.

This option can turned on/off also while the test is already running, and will take immediate effect, starting/stopping/resuming the analysis.

As the analysis is quite computationally expensive, the algorithm will be activated when the sample assumes a likely shape.

The activation is controlled by the sub-option Contact angle limit for sessile capillarity (0=no) (default=`100`).
The Young-Laplace solution will not be attempted unless the contact angle between the base and the sample reaches this angle.

Another sub-option allows to tune the Runge-Kutta integration step used by the numerical solver.

During this phase, Misura will create two adimensional sample datasets which contain the solution to the Young-Laplace equation:


	Capillary factor beta


	Scaling factor r0







The Surface Tension plugin

If the sessile drop analysis was enabled during the test execution,
the Surface Tension plugin can be called from the sample<N> node corresponding to the analyzed sample, in the Misura™ Navigator.

The surface tension plugin will ask to the user all remaining physical sample properties in order to calculate a proper surface tension
from the adimensional parameters calculated by the image analysis.

[image: ../_images/surface_tension_plugin.png]

Pre-compiled fields


	Capillary factor dataset: this pre-compiled field contains the reference to the adimensional beta dataset obtained by the sessile drop analysis.


	Scaling factor dataset: referring to the adimensional r0 dataset.


	Sample temperature: referring to the sample’s temperature dataset.


	Output dataset name: the name where to save the calculated surface tension. It is possible to save multiple datasets corresponding to different configurations.







Sample density


	Reference sample density: density of the sample at the reference temperature.


	Reference sample temperature: reference temperature at which the reference sample density is measured.




Sample thermal expansion, which Will be used to correct sample density by temperature:


	Sample expansion: if left blank, assume no expansion (and no density change). Else, point to an expansion % dataset for the material (height, volume or the expansion curve coming from a dilatometer).


	Sample expansion temperature: if the sample expansion datasets comes from a different test (a dilatometer) this field should point to the sample’s temperature of that test.


	Extrapolate below temperature: do no trust expansion values below this temperature. Use linear extrapolation instead.


	Extrapolate above temperature: do no trues expansion values above this temperature. Use linear extrapolation instead.


	Sample expansion dimension: specify if the Sample expansion dataset is linear or volumetric.







Atmosphere density


	Reference gas density: Gas density at the reference temperature.


	Reference gas temperature: Reference density at which the reference gas density is measured.




Gas thermal expansion, which will be used to correct gas density by temperature:


	Gas expansion: if left blank, assume reference air expansion.Else, point to an expansion % dataset for the gas.


	Gas expansion temperature: temperature dataset used for the gas expansion values.


	Gas expansion dimension: specify if the Gas expansion dataset is linear or volumetric.












          

      

      

    

  

    
      
          
            
  
Horizontal Optical Dilatometer

Misura™ Horizontal Optical Dilatometer measures the dimensional changes of materials through patented True Differential, double-beam technology.

The following sections contain instruction about how to start a test, prepare a sample and analyze test results.



	Quick Start: Running an Horizontal Dilatometer Test
	Horizontal Dilatometer Acquisition Window

	Adjusting cameras position

	Setting initial sample dimension

	Stopping the test on excess deformation





	Sample preparation for the Horizontal Optical Dilatometer

	Quick Start: Browsing an Horizontal Dilatometer file
	Opening the output file

	Test Configuration and Data

	Interacting with the Data Plot













          

      

      

    

  

    
      
          
            
  
Quick Start: Running an Horizontal Dilatometer Test

This section documents specific dilatometric functions. Read Live Acquisition for a general description of the acquisition window.


Horizontal Dilatometer Acquisition Window

The Horizontal Dilatometer Live Acquisition window additionally comprises:



	Two Camera controller windows with X, Y motion controllers.


	Global Focus motion controllers.


	Sample Total displacement information displayed on the Status panel panel, updated realtime during the analysis.


	One Samples tab in the left Test Configuration area.







The workflow for an horizontal dilatometer test follows the general rules described in section Live Acquisition.




Adjusting cameras position

The initial position of the camera should be automatically reached during instrument initialization, as described in Motion Control.

Use the X motion control under each camera to find the border of the sample, which should appear as a vertical division line between a white and a black area, where the black represents the sample.

In case of indented sample borders, use the Y motion control to frame the most planar section of the surface.

Once the position of the camera has been established you have to find the right focal distance, by moving the focus slider on the bottom of the Acquisition window.

It is advisable to close the furnace before starting a new tests. Vibrations produced during furnace movements can slightly change the sample position.




Setting initial sample dimension

The Horizontal Optical Dilatometer measures changes in length, but cannot measure the initial length of the sample.

The operator must measure it before starting a test, by using a high precision caliper.




Stopping the test on excess deformation

In thermal cycle tab, under Additional Control Options section, the Horizontal Optical Dilatometers offers a security option to stop the test whenever deformation exceeds a configurable threshold, Stop on deformation excess.

The security limits are +10 and -10 and are active by default.

This option helps preventing sample melting in the furnace. In many cases melting will raise image analysis errors which will stop the acquisition anyway. Nevertheless, under some circumstances there is no way to detect melting from the border image.

We advise to enable this option and set reasonable limits for the specific material analysed.







          

      

      

    

  

    
      
          
            
  
Sample preparation for the Horizontal Optical Dilatometer

The optical dilatometer frames two opposite sides of the sample with two independent optics.

In order to achive the best focus the sample should be:



	machined to a trapezoidal shape, in such a way that the lengths of the faces parallel to the optical path are minimized


	placed on an alumina holding plate, in order to avoid elastic friction with holding rods


	aligned to the end of the holding rods, in such a way that the border distances from the optics are equal and the focus distance is the same


	placed in the middle of the furnace, so that the maximum expansion excursion is available both towards the left optic and towards the right optic











          

      

      

    

  

    
      
          
            
  
Quick Start: Browsing an Horizontal Dilatometer file

This Demo will guide you through the data analysis of Horizontal Dilatometer (horizontal) output files.

In order to follow the tutorial you should:



	Download and Install Misura™ (see Installation).


	Get the sample file Horizontal Dilatometer Sample File 1.h5 and save it to a known location (eg: your Desktop)








Opening the output file


	Run browser.exe application from the folder where you extracted Misura™, or run the link you created on your desktop.


	In the Recent data sources window, under the first column Recent files, click on Add button.


	Browse to the location where you downloaded Horizontal Dilatometer Sample File 1.h5, select and open it.


	The loading process will start. If the file is considerably big (several GB) or located on network or slow storage drive, it may take several seconds to open.


	The file is displayed on a new tab, on the right of the Databases tab.




The test file tab is divided in three areas:


	A menu bar in the upper part of the window


	A right area called Test Configuration. It is divided in at least 4 vertical tabs: Measure, Thermal Cycle, Sample0 and Results.


	A central area displaying movable and resizable sub-windows, where you see the Data Plot window.







Test Configuration and Data

The most relevant configuration options used for the test run and output results are displayed in the right Test Configuration area.


Measure overview

The first Measure tab contains the list of options regarding the test run.

Detect the following:


	Name: Name of the test run, set by the operator anytime before the end of the test.


	Operator: the login name used by the operator who started the test.


	Type: The type of the test (usually Standard or Calibration).


	Elapsed time: the total duration of the test.







Thermal cycle

This tab contains a table with points defining the thermal cycle and a graph with a cartesian representation.

The graph displays two curves: the red line is the setpoint temperature; the blue line is the heating rate.

If you cannot see the axes and their labels, enlarge the application window and the Test Configuration area.




Sample data

Most relevant data in the Sample0 tab are:


	Name: if set, the name the operator gave to this specific sample. It is mainly useful for multi-sample measurement.


	Initial sample dimension: the operator must set this value to the initial sample length, measured with another instrument (eg: a digital micrometer).


	Record frames/profiles: did the operator required full frames and (x,y) sample profiles to be recorded onto the output file? They are usually turned off.




You can ignore Border angle, Motion start, Total displacement, Cumulative error options an all their nested options, as they are only useful during live acquisition.




Results

The Results tab displays the Navigator tree component. It is the tree of recorded datasets (curves), organized by groups. Each group represents a part of the instrument or of the measurement.

For example:


	/horizontal element represents the Horizontal Dilatometer instrument itself. It generates no datasets, but contains one sample (sample0).


	/kiln element represents the furnace, and contains datasets regarding temperature control (T, temperature; S, setpoint; P, power; etc).




We will see it in detail in next sections, as it is the most powerful and versatile component of the interface.






Interacting with the Data Plot

The Misura™ Navigator tree is the gate to the most important actions you can perform on the data plot.

In order to plot one more dataset (for example the temperature setpoint):


	Right-click on the dataset you wish to plot on the Navigator tree (/kiln/S).


	Select the Plot action from the context menu.




The same apply for removing a dataset and all its related objects from the plot. The Plot action will be checked if the curve is visible, unchecked if not visibile.

The setpoint curve plot is now referred to its own axis labelled S (°C). To better compare temperature and setpoint, it is useful to refer the setpoint plot to the temperature axis:


	Right-click on the setpoint curve on the Data Plot window. Select Properties from the context menu.


	A new dialog window opens, listing all the properties of the plotted curve. Search for the bold Y axis entry.


	Change Y axis from ax:S to ax:T. The curve will be immediately referred to the T (°C) axis.




The S (°C) axis loses its scale (it’s now from 0 to 1). It’s no longer useful, so you can hide it:


	Right-click on the S (°C) axis, select Properties.


	The first entry is Hide. Check the checkbox. The axis disappears.




You can freely move any axis by clicking on it and dragging.


Viewing dilatation as Percentile

The /horizontal/sample0/d dataset represents dilatation. It is recorded in microns, but is frequently useful to analyze it as a percentile of the total initial length of the sample. The initial length was measured with a manual digital micrometer, and set before starting the test.

Follow these steps to convert the curve to percentile:


	Locate the d (/horizontal/sample0/d) element in the Navigator tree under Results tab.


	Right-click and select Percentile.


	A dialog will appear. Click Apply.


	A new temporary label in the dialog confirms the dataset was created (Done). Click Close.


	If the curve is currently plotted, you immediately view the effect in the graph.




It may happen that the operator forget to measure the sample, or inserts a wrong initial dimension. If the thermal treatment modify the structure of your material, the test must be repeated. In case you are able to recover the correct intial dimension, or you are confident that you can measure it after the test run, you can change its value.


	Locate the d element in the Navigator tree.


	Right-click and select Set Initial Dimension.


	Insert the correct value in Initial dimension value.


	De-select OR, automatic calculation based on first points checkbox.


	Click Apply then Close.




If the curve is currently plotted in percentile, you will se the axis scale changing accordingly to the new initial dimension set.




Evaluating the Coefficient of Expansion

The coefficient of expansion is calculated from the d dataset, the initial dimension and the temperature. To create the coefficient curve:


	Locate the d element in the Navigator tree.


	Right-click and select Linear Coefficient.


	Click Apply and Close.


	The Navigator tree is updated. The d element now has a child: Coefficient(T,d). This is the coefficient of expansion.


	Plot the coefficient dataset using its context menu.




The curve will be referred to a new axis Coeff(50). The number 50 in the label means the coefficient was calculated starting from 50°C.
The scale of the axis will be around 10-6 - 10-5. You can rescale the axis to a more comfortable multiplier:


	Right-click on the Coeff(50) axis. Select Properties action.


	Locate the Scale entry and set it to 1e6.




Now the scale of the axis should go from 2.5 to 12.5, where the multiplier is 10-6.




Calibrating with a known standard

By comparing the measured expansion curve of a standard material with theoretical values, it is possible to calculate a calibration factor
which can then be applied directly during the measurement.
The calibration factor will be multiplied by the observed expansion, acting as a slope correction on the whole expansion curve.

If the factor is less than one, it means the measured curve of the standard material was higher than the theoretical, so all measurements will be reduced by that number.
In case the factor is greater than one, it means the measurement was lower: all subsequent measurements will be increased accordingly.

To execute the calibration tool, open the test in the Browser or Graphics, then:


	Locate the d element in the Navigator tree.


	Right-click and select Calibration.


	Select the Calibration standard, start/end temperature and display options.


	Click Apply and Close.




When launched through this sequence, the calibration plugin dialog will show pre-filled fields for Expansion dataset and Temperature dataset:

[image: ../_images/plugin_calibration.png]
Other options include:


	Calibration Standard chooser contains a list of materials having certified expansion curves.


	First temperature margin determines the temperature interval to discard from the start of the test.
When the test starts, thermal control might induce imperfections in the heating rate, due to furnace inertia.
This options allows to ignore the initial part of the curve.


	Last temperature margin allows to discard a temperature interval at the end of the test.


	Draw calibration label will create a text label on the currently selected plot page, and output the calibration factor and standard deviation.


	Add calibration datasets will add the theoretical expansion values and a polynomial fit of the measured values to two child datasets.
Those curves can later be plotted.


	Start index allows to skip initial points by index (second) - alternative to First temperature margin




Example navigator tree after the creation of calibration datasets:

[image: ../_images/plugin_calibration_datasets.png]
Example calibration plot with calibration label and plotted standard:

[image: ../_images/plugin_calibration_plot.png]
The calibration factor can then be copied from the label and configured in the Settings ‣ Instrument panel under ref:live_acquisition.

This procedure works both on native Misura™ tests and on imported Misura3 tests.









          

      

      

    

  

    
      
          
            
  
Vertical Optical Dilatometer

Misura™ Vertical Optical Dilatometer measures the dimensional changes of materials through patented True Differential, double-beam technology.



	Quick Start: Running a Vertical Dilatometer test
	Vertical Dilatometer Acquisition Window

	Adjusting cameras position

	Setting initial sample dimension

	Stopping the test on excess deformation





	Sample preparation for the Vertical Optical Dilatometer

	Quick Start: Browsing a Vertical Dilatometer file
	Opening the output file

	Test Configuration and Data

	Interacting with the Data Plot













          

      

      

    

  

    
      
          
            
  
Quick Start: Running a Vertical Dilatometer test

This section documents specific dilatometric functions. Read Live Acquisition for a general description of the acquisition window.


Vertical Dilatometer Acquisition Window

The Vertical Dilatometer Live Acquisition window additionally comprises:



	Two Camera controller windows with X, Y motion controllers.


	Global Focus motion controllers.


	Sample Total displacement information displayed on the Status panel panel, updated realtime during the analysis.


	One Samples tab in the left Test Configuration area.







The workflow for an vertical dilatometer test follows the general rules described in section Live Acquisition.




Adjusting cameras position

The initial position of the camera should be automatically reached during instrument initialization, as described in Motion Control.

Use the Y motion control on the left side of each camera to find the border of the sample and of the holding plate. They both appear as an horizontal division line between a white and a black area, where the black represents the sample for the Height camera and the holding plate for the Base camera.

In case of indented sample borders, use the X motion control to frame the most planar section of the surface.

Once the position of the camera has been established you have to find the right focal distance, by moving the focus slider on the bottom of the Acquisition window.

It is advisable to close the furnace before starting a new tests. Vibrations produced during furnace movements can slightly change the sample position.




Setting initial sample dimension

The Vertical Optical Dilatometer measures changes in length, but cannot measure the initial length of the sample.

The operator must measure it before starting a test, by using a high precision caliper.




Stopping the test on excess deformation

The vertical dilatometer is designed to follow the sample until complete melting. Nevertheless, this might pose the risk of sample flowing below the sample holder if its viscosity drops down enough.

In thermal cycle tab, under Additional Control Options section, the Horizontal Optical Dilatometers offers a security option to stop the test whenever deformation exceeds a configurable threshold, Stop on deformation excess.

The security limits are +25 and -50 and are active by default.

This option helps preventing sample flowing in the furnace.

We advise to enable this option and set reasonable limits for the specific material analysed.







          

      

      

    

  

    
      
          
            
  
Sample preparation for the Vertical Optical Dilatometer

The optical dilatometer frames two opposite sides of the sample with two independent optics.

In order to achive the best focus the sample should be:



	machined with a triangular tip, in such a way that the length of the upper face parallel to the optical path is minimized


	the long side of the sample should face the optics and be aligned with the holding plate











          

      

      

    

  

    
      
          
            
  
Quick Start: Browsing a Vertical Dilatometer file

This Demo will guide you through the data analysis of Vertical Dilatometer (vertical) output files.

In order to follow the tutorial you should:



	Download and Install Misura™ (see Installation).


	Get the sample file Vertical Dilatometer Sample File 1.h5 and save it to a known location (eg: your Desktop)








Opening the output file


	Run browser.exe application from the folder where you extracted Misura™, or run the link you created on your desktop.


	In the Recent data sources window, under the first column Recent files, click on Add button.


	Browse to the location where you downloaded Vertical Dilatometer Sample File 1.h5, select and open it.


	The loading process will start. If the file is considerably big (several GB) or located on network or slow storage drive, it may take several seconds to open.


	The file is displayed on a new tab, on the right of the Databases tab.




The test file tab is divided in three areas:


	A menu bar in the upper part of the window


	A right area called Test Configuration. It is divided in at least 4 vertical tabs: Measure, Thermal Cycle, Sample0 and Results.


	A central area displaying movable and resizable sub-windows, where you see the Data Plot window.







Test Configuration and Data

The most relevant configuration options used for the test run and output results are displayed in the right Test Configuration area.


Measure overview

The first Measure tab contains the list of options regarding the test run.

Detect the following:


	Name: Name of the test run, set by the operator anytime before the end of the test.


	Operator: the login name used by the operator who started the test.


	Type: The type of the test (usually Standard or Calibration).


	Elapsed time: the total duration of the test.







Thermal cycle

This tab contains a table with points defining the thermal cycle and a graph with a cartesian representation.

The graph displays two curves: the red line is the setpoint temperature; the blue line is the heating rate.

If you cannot see the axes and their labels, enlarge the application window and the Test Configuration area.




Sample data

Most relevant data in the Sample0 tab are:


	Name: if set, the name the operator gave to this specific sample. It is mainly useful for multi-sample measurement.


	Initial sample dimension: the operator must set this value to the initial sample length, measured with another instrument (eg: a digital micrometer).


	Record frames/profiles: did the operator required full frames and (x,y) sample profiles to be recorded onto the output file? They are usually turned off.




You can ignore Border angle, Motion start, Total displacement, Cumulative error options an all their nested options, as they are only useful during live acquisition.




Results

The Results tab displays the Navigator tree component. It is the tree of recorded datasets (curves), organized by groups. Each group represents a part of the instrument or of the measurement.

For example:


	/vertical element represents the Vertical Dilatometer instrument itself. It generates no datasets, but contains one sample (sample0).


	/kiln element represents the furnace, and contains datasets regarding temperature control (T, temperature; S, setpoint; P, power; etc).




We will see it in detail in next sections, as it is the most powerful and versatile component of the interface.






Interacting with the Data Plot

The Misura™ Navigator tree is the gate to the most important actions you can perform on the data plot.

In order to plot one more dataset (for example the temperature setpoint):


	Right-click on the dataset you wish to plot on the Navigator tree (/kiln/S).


	Select the Plot action from the context menu.




The same apply for removing a dataset and all its related objects from the plot. The Plot action will be checked if the curve is visible, unchecked if not
visibile.

The setpoint curve plot is now referred to its own axis labelled S (°C). To better compare temperature and setpoint, it is useful to refer the setpoint plot
to the temperature axis:


	Right-click on the setpoint curve on the Data Plot window. Select Properties from the context menu.


	A new dialog window opens, listing all the properties of the plotted curve. Search for the bold Y axis entry.


	Change Y axis from ax:S to ax:T. The curve will be immediately referred to the T (°C) axis.




The S (°C) axis loses its scale (it’s now from 0 to 1). It’s no longer useful, so you can hide it:


	Right-click on the S (°C) axis, select Properties.


	The first entry is Hide. Check the checkbox. The axis disappears.




You can freely move any axis by clicking on it and dragging.


Viewing dilatation as Percentile

The /vertical/sample0/d dataset represents dilatation. It is recorded in microns, but is frequently useful to analyze it as a percentile of the total
initial length of the sample. The initial length was measured with a manual digital micrometer, and set before starting the test.

Follow these steps to convert the curve to percentile:


	Locate the d (/vertical/sample0/d) element in the Navigator tree under Results tab.


	Right-click and select Percentile.


	A dialog will appear. Click Apply.


	A new temporary label in the dialog confirms the dataset was created (Done). Click Close.


	If the curve is currently plotted, you immediately view the effect in the graph.




It may happen that the operator forget to measure the sample, or inserts a wrong initial dimension. If the thermal treatment modify the structure of your
material, the test must be repeated. In case you are able to recover the correct intial dimension, or you are confident that you can measure it after the test
run, you can change its value.


	Locate the d element in the Navigator tree.


	Right-click and select Set Initial Dimension.


	Insert the correct value in Initial dimension value.


	De-select OR, automatic calculation based on first points checkbox.


	Click Apply then Close.




If the curve is currently plotted in percentile, you will se the axis scale changing accordingly to the new initial dimension set.




Evaluating the Coefficient of Expansion

The coefficient of expansion is calculated from the d dataset, the initial dimension and the temperature. To create the coefficient curve:


	Locate the d element in the Navigator tree.


	Right-click and select Linear Coefficient.


	Click Apply and Close.


	The Navigator tree is updated. The d element now has a child: Coefficient(T,d). This is the coefficient of expansion.


	Plot the coefficient dataset using its context menu.




The curve will be referred to a new axis Coeff(50). The number 50 in the label means the coefficient was calculated starting from 50°C. The scale of the axis
will be around 10-6 - 10-5. You can rescale the axis to a more comfortable multiplier:


	Right-click on the Coeff(50) axis. Select Properties action.


	Locate the Scale entry and set it to 1e6.




Now the scale of the axis should go from 2.5 to 12.5, where the multiplier is 10-6.









          

      

      

    

  

    
      
          
            
  
Absolute Optical Fleximeter

Misura™ Absolute Optical Fleximeter measures the dimensional changes of materials through patent-pending True Differential, triple-beam technology.

The relative fleximeter only uses one camera and needs a calibration curve to be subtracted from the measurement.

The following sections contain instruction about how to start a test, prepare a sample and analyze test results.



	Quick Start: Running an Absolute Optical Fleximeter Test
	Fleximeter Acquisition Window

	Adjusting cameras position





	Sample preparation for the Absolute Optical Fleximeter

	Quick Start: Browsing an Absolute Fleximeter file
	Opening the output file

	Test Configuration and Data

	Interacting with the Data Plot













          

      

      

    

  

    
      
          
            
  
Quick Start: Running an Absolute Optical Fleximeter Test

This section documents specific dilatometric functions.
Read Live Acquisition for a general description of the acquisition window.


Fleximeter Acquisition Window

The Absolute Fleximeter Live Acquisition window additionally comprises:



	Three Camera controller windows. Two lateral (right/left) cameras with X, Y motion controllers and one center camera with Y motion controller.


	Global Focus motion controllers.


	Sample Total displacement information displayed on the Status panel panel, updated realtime during the analysis.


	One Samples tab in the left Test Configuration area.







The workflow for an Absolute Fleximeter test follows the general rules described in section Live Acquisition.




Adjusting cameras position

The initial position of the camera should be automatically reached during instrument initialization, as described in Motion Control.

Use the Y motion control on the left side of each camera window to find the border of the sample, which should appear as an horizontal division line between a white and a black area, where the black represents the sample.

X motion controllers should not be changed, unless default positions make it impossible to carry out the test.

Once the position of the camera has been established you have to find the right focal distance, by moving the focus slider on the bottom of the Acquisition window.

It is advisable to close the furnace before starting a new tests. Vibrations produced during furnace movements can slightly change the sample position.







          

      

      

    

  

    
      
          
            
  
Sample preparation for the Absolute Optical Fleximeter

The absolute fleximeter frames three points on the bottom side of the sample with three independent optics.

In order to achive the best focus the sample should be:



	aligned to the end of the middle holding rods, in such a way that the border distances from the optics are equal and the focus distance is the same











          

      

      

    

  

    
      
          
            
  
Quick Start: Browsing an Absolute Fleximeter file

This Demo will guide you through the data analysis of Absolute Fleximeter (flex) output files.

In order to follow the tutorial you should:



	Download and Install Misura™ (see Installation).


	Get the sample file Absolute Fleximeter Sample File 1.h5 and save it to a known location (eg: your Desktop)








Opening the output file


	Run browser.exe application from the folder where you extracted Misura™, or run the link you created on your desktop.


	In the Recent data sources window, under the first column Recent files, click on Add button.


	Browse to the location where you downloaded Absolute Fleximeter Sample File 1.h5, select and open it.


	The loading process will start. If the file is considerably big (several GB) or located on network or slow storage drive, it may take several seconds to open.


	The file is displayed on a new tab, on the right of the Databases tab.




The test file tab is divided in three areas:


	A menu bar in the upper part of the window


	A right area called Test Configuration. It is divided in at least 4 vertical tabs: Measure, Thermal Cycle, Sample0 and Results.


	A central area displaying movable and resizable sub-windows, where you see the Data Plot window.







Test Configuration and Data

The most relevant configuration options used for the test run and output results are displayed in the right Test Configuration area.


Measure overview

The first Measure tab contains the list of options regarding the test run.

Detect the following:


	Name: Name of the test run, set by the operator anytime before the end of the test.


	Operator: the login name used by the operator who started the test.


	Type: The type of the test (usually Standard or Calibration).


	Elapsed time: the total duration of the test.







Thermal cycle

This tab contains a table with points defining the thermal cycle and a graph with a cartesian representation.

The graph displays two curves: the red line is the setpoint temperature; the blue line is the heating rate.

If you cannot see the axes and their labels, enlarge the application window and the Test Configuration area.




Sample data

Most relevant data in the Sample0 tab are:


	Name: if set, the name the operator gave to this specific sample. It is mainly useful for multi-sample measurement.


	Initial sample dimension: the operator must set this value to the initial sample length, measured with another instrument (eg: a digital micrometer).


	Record frames/profiles: did the operator required full frames and (x,y) sample profiles to be recorded onto the output file? They are usually turned off.




You can ignore Border angle, Motion start, Total displacement, Cumulative error options an all their nested options, as they are only useful during live acquisition.




Results

The Results tab displays the Navigator tree component. It is the tree of recorded datasets (curves), organized by groups. Each group represents a part of the instrument or of the measurement.

For example:


	/flex element represents the Absolute Fleximeter instrument itself. It generates no datasets, but contains one sample (sample0).


	/kiln element represents the furnace, and contains datasets regarding temperature control (T, temperature; S, setpoint; P, power; etc).




We will see it in detail in next sections, as it is the most powerful and versatile component of the interface.






Interacting with the Data Plot

The Misura™ Navigator tree is the gate to the most important actions you can perform on the data plot.

In order to plot one more dataset (for example the temperature setpoint):


	Right-click on the dataset you wish to plot on the Navigator tree (/kiln/S).


	Select the Plot action from the context menu.




The same apply for removing a dataset and all its related objects from the plot. The Plot action will be checked if the curve is visible, unchecked if not visibile.

The setpoint curve plot is now referred to its own axis labelled S (°C). To better compare temperature and setpoint, it is useful to refer the setpoint plot to the temperature axis:


	Right-click on the setpoint curve on the Data Plot window. Select Properties from the context menu.


	A new dialog window opens, listing all the properties of the plotted curve. Search for the bold Y axis entry.


	Change Y axis from ax:S to ax:T. The curve will be immediately referred to the T (°C) axis.




The S (°C) axis loses its scale (it’s now from 0 to 1). It’s no longer useful, so you can hide it:


	Right-click on the S (°C) axis, select Properties.


	The first entry is Hide. Check the checkbox. The axis disappears.




You can freely move any axis by clicking on it and dragging.


Viewing flexion in micron unit

The /flex/sample0/d dataset represents flexion. It is recorded in microns and automatically converted to percentile on dataset loading, but is frequently useful to analyze it as an absolute value in microns. The percentile is calculated towards the distance between the flex rods, set before starting the test.

Follow these steps to convert the curve back to microns:


	Locate the d (/flex/sample0/d) element in the Navigator. #. Right-click and select the flagged action Percentile.


	A dialog will appear. Click Apply.


	A new temporary label in the dialog confirms the dataset was created (Done). Click Close.


	If the curve is currently plotted, you immediately view the effect in the graph.


	By right-clicking again on the dataset node the Percentile action is now unflagged.












          

      

      

    

  

    
      
          
            
  
Misura™ Browser

Misura™ Browser allows to evaluate the results of a test run and to access to the full measurement instrument configuration.

The browser has a tab interface, where the first tab is reserved to Databases, and any  additional tab represents a test file.

Each test is saved into a single test file in standard HDF5 file format.
Test files and can be indexed into one or more databases to ease up search and organization.



	Data Sources
	Database Indexes

	Database Dialog





	Test Window
	Basic Plotting and Embedding

	Re-calculate metadata

	Versioning













          

      

      

    

  

    
      
          
            
  
Data Sources

Data Sources is always the first Browser’s tab, and is not possible to close it. The tab is mostly empty, displaying the gray background.

Any HDF5 Misura file can be dragged from your file system browser and dropped into this gray area.
The file will be immediately opened in a new tab.

The only visible sub-window on startup is Recent Data Sources, displaying two columns: one for recently opened files; one for recently accessed databases.
More columns might be displayed by plugins.

The recently opened tests listing is a quick way to directly re-open any recent file, no matter if it is indexed in a database.
To open a file from the recent files column, either:


	Double-click on the file


	Select the file, then click on the Open selected button


	Click on the Add button then select the file anywhere from the file-system.


	If any data import plugin is enabled, an Import button is also visible,
which allows to select a foreign data format and convert it to a compatible HDF5. The converted file will be opened.




[image: ../_images/databases.png]
If a recent file is double-clicked from the list, or selected from the file system using the , it is opened in a new Test Window, in a new tab.
The more recently accessed file is placed at the top of the list.

The more convenient way to open a test file is to query the database index.


Database Indexes

Misura™ databases are a way to organize and search large amounts of tests, and for finding or establishing relations between them.

They are advanced indexes, collecting all important information about each test (metadata) but not storing any raw dataset.

They are ephermeral, in the sense that they can be safely removed and recreated identical from the same set of files.
They do not hold any unique information about your test. All information is actually saved only into the test files or into the plotting files.

There should always be a default database defined at the top of the list.
This is the database where finished tests are automatically saved and indexed, configured in Preferences under Default database option.

If you would like to open a database which is not listed in the Recent databases column, you can Add it from the below button,
or click on File ‣ Open database menu action in the main Browser window.

You can create a database index out of any structure of folders containing some Misura tests (and any other file type, which will be skipped).
To create a new database, select the File -> New database menu action. It will ask the name and location of the database index.
The database index must be placed on the topmost folder in your folder structure.
After confirmation, the folder where the database index is being created will be scanned as well as any sub-folder, recursively.

Databases can be located on a network share, to enable multi-user collaboration.
Every client which needs to access the output files or the machine can configure it as its Default database in Preferences,
so finished tests are automatically added to that location only once.

This is an easy way to collaborate on data post-processing. It is advisable to save also the plots in the same, shared folder,
so any user participating in the network will be able to open them.


Warning

You might experience problems if a Linux client is accessing a database on a windows share through Samba. You will probably need to disable byte range locks by setting the nobrl flag when mounting the CIFS filesystem. Example /etc/fstab entry: //192.168.0.1/database /media/database cifs rw,users,nobrl,user=misura,pass=xxxx,exec 0 0






Database Dialog


	The interface towards a database is the Database Dialog. A new database dialog sub-window will be added to the Data Sources tab

	every time a database index is opened.





It shows a listing with all indexed tests, plus a query line with some filtering options to filter the list.

The toolbar holds two buttons: Refresh, Rebuild.


	Refresh will search for indexed files that no longer exist and for new files that are still not indexed.


	Rebuild will clear the current listing and rebuild entirely from the files found in the same folder or below the folder where the database file is located.




The query line allows to match the input line against one database column at a time. Select the column name, insert the text to be searched and press enter. A special All filter will match simple text against all text column (name, file name, id, instrument type, etc).

Every line listed in the table represents one test. By double-clicking on a line, the test is opened in a new browser’s tab. By right-clicking on a line, a context menu displays some actions relative to the selected test:


	Open selected tests: open the currently selected test (as double-click).
Multiple lines can be selected by pressing Ctrl key while clicking. In case multiple lines were selected, all tests will be opened in new tabs.


	Add to: This action displays a sub-menu, listing all currently opened tabs (tests).
By clicking on a tab name, the selected test will be added to the already opened tab.
In this way, it is possible to compare multiple tests in the same browser window.


	View folder: Open the file system folder containing the test file.


	Delete: Delete selected file/s. Will ask a confirmation.




While cells Name or Column are selected, it is possible to press the F2 key to rename the test or edit the comment.

The database dialog can be created also from Plotting menu, Misura ‣ Recent databases.
In this case, double-clicking on a test will add its datasets to the active document, and default plots to be created and overimposed to any existing plot.







          

      

      

    

  

    
      
          
            
  
Test Window

The Misura™ Test Window opens in Browser’s tabs once a test has been selected.

Its appearance is very similar to the Live Acquisition window, with a central area displaying a plot and a lateral area showing test configurations and data Navigator.

The values contained in the configuration tabs (Measure, Sample 0…n, Thermal Cycle) are the ones recorded at the end of the test.


Basic Plotting and Embedding

At the opening of the test, a standard plot is displayed. In order to interact with this plot, switch to Results tab in the left panel.

You can operate on the plot with the usual Navigator functions (un/plotting a curve, smoothing, deriving, etc). You can also create a test report on a new plot page.

Once you are satisfied by your plot, you can permanently save into the test file.


	From Measure menu, click on Plots submenu.


	Select Save new plot. Give a name to your plot.


	Your new plot will appear in the Plots submenu.




Saved plots can be recalled, overwriting any current plot.




Re-calculate metadata

The logic by which characteristic or important points are identified during the test is saved onto the test file. Through the Browser it is possible to change and replay this logic, for research purposes.

The replay is accessible from the  Measure menu, at the Re-calculate metadata action. All affected values will be recalculated. If the target value is unchanged, refresh it by hovering with the mouse.




Versioning

The original data cannot be modified or removed from a test file.

A versioning mechanism allows to change any configuration option and any metadata and save everything in a new test version. Multiple versions can be saved in each test file.

Multiple plots can also be saved under the version that generated them and recalled.

Versioning allows, for example, to correct the test name, or add a comment, or manually edit characteristic shapes. To save a new version, starting from a file containing only the original data:


	Do your changes to any configuration option


	Click on menu Measure ‣ Version ‣ New version and plot


	A dialog box will ask the label of the new version.




After a new version is created, the Version menu will show an additional, checked sub-menu below the Original one. The version submenu allows to:


	Load version: reload the configuration options from the parent version. This menu action is checked in the current version.


	Delete version: remove the parent version and any associated plot.


	Overwrite version: overwrite saved configuration.


	Save new plot: save current plot as a new plot associated to the current version, with a new name.




The Original version cannot be overwritten nor deleted, and only displays the Load version action.

Below these version-submenu actions, all associated plots are listed as sub-menu. Each plot-submenu has three entries:


	
	Load plot: loads the selected plot. If the plot pertain to a version which is not current, the parent version will be loaded instead.

	The current plot will be deleted and replaced with the loaded one. By hovering the mouse over the load action, a preview of the plot will pop-up.







	Overwrite plot: overwrite that plot.


	Delete plot: delete that plot.




[image: ../_images/version_menu.png]






          

      

      

    

  

    
      
          
            
  
Plotting

Misura™ is built upon Veusz [http://home.gna.org/veusz/], an advanced scientific plotting package.

Veusz [http://home.gna.org/veusz/]’s website contains the basic documentation needed to start using its plotting features (this introductory video [https://vimeo.com/14577084] can be a good starting point).

Once you know the basics of Veusz [http://home.gna.org/veusz/], you can start using proficiently Misura™ plugins.


Misura™ Menu

Misura™ Menu is composed of the following entries:


	Recent Files - shows the most recent N opened file. N can be modified in Preferences (defualt value is 15)


	Recent Databases - shows the most recent N databases. N can be modified in Preferences (defualt value is 10)


	Open File - opens a dialog boxes to locate and load a new test file.


	Opened Tests Navigator - shows/hide the Misura™ Misura™ Navigator panel


	Preferences - opens Preferences.







Tools

Useful plotting tools, specifically created for Misura™ and not documented in Veusz [http://home.gna.org/veusz/], are listed in the following chapters.



	DataPoint
	Creating a DataPoint

	Positioning

	Labels

	Lines

	Remove Gaps















          

      

      

    

  

    
      
          
            
  
DataPoint

A DataPoint represents an highlighted point on a plotted curve.
It is subordered to that curve and strictly bound to its fate. If the curve is deleted, the DataPoint gets deleted also.
If some aspect of the curve change, like the x or y dataset or axis, the DataPoint is adjusted accordingly.


Creating a DataPoint

There are two methods of placing a new DataPoint on a curve:


	Activate the picker tool and click on a curve. A new DataPoint will be created, associated to the curve you clicked onto,
and as near as possible to the coordinates where your click happened.


	Select the curve in the Misura™ Navigator, then right click on its node and select the Intercept action.
A plugin window will allow to customize the location where the DataPoint will appear and some additional settings.







Positioning

Once created, a DataPoint can be positioned by dragging and dropping it along its curve (it will never jump to another curve).

Its exact positioning, once dropped, can follow different algorithms, which makes it a powerful analytical tools.
For example, a DataPoint can search for the nearest maximum, minimum or inflection point in the target curve.

Placement options can be configured before creating a datapoint according to method (2) above (Intercept from Misura™ Navigator)
by setting the Place nearest field.
Once the DataPoint has been created with either method, placement algorithm can be modified from the Place nearest setting
found in the Properties panel.


	Nearest (fixed X): the default method will consider the X coordinate of your click, and place the DataPoint the nearest possible to that value,
without considering the Y coordinate.


	Nearest: as above, but will consider also the Y coordinate. Use this method when there is a non-univocal curve (multiple Y for the same X).


	Maximum: search the nearest maximum value


	Minimum: as above, looking for the minimum


	Inflection: search the nearest point where the second derivative is zero


	Stationary: as above, but use the first derivative




Inflection and Stationary methods will need an addtional X dataset in order to calculate the derivatives.
The DataPoint is initialized with the same X dataset of the parent curve, but that can be changed in the Critical search X dataset setting.

The surrounding portion of the curve, in which the automatic positioning will occur, is defined by Critical search range option.
It is expressed as the number of points around the current position of the DataPoint where to search according to the selected method.
This allows a precise local search of the desired morphological feature of the curve.




Labels

DataPoint creates a subordered label listing the Y value, temperature and time of the point. The label can be deleted
by setting Show label to False under the Formatting panel of the DataPoint.

The label can be customized in Output label text folling Python replacement rules. Available substitutions are:


	y: y value (%(y).1f will output 1.2 if y is 1.234)


	x: x value, as above


	ylabel: the label of the y axis, use the string formatter: %(ylabel)s


	xlabel: x axis label, as above


	t: time value


	T: temperature value




For example:


Intercept\\%(ylabel)s=%(y).1E\\T=%(T).1f\\t=%(t)i




Will render as:


Intercept

Vol (%)=5.1E

T=840.1

t=2800






Lines

The Formatting panel offers three kinds of subordered lines:


	Show tangent line: a line tangent to the curve will be added


	Show perpendicular line: a line perpendicular to the curve will be added


	Second Data Point: specify a second DataPoint: a line will be drawn which passes through both the current DataPoint and that second DataPoint.




After one of these option is activated, it might be necessary to move the DataPoint on the plot for the related lines to show up.
Alternatively, you can click the Update Data Point button a few times.




Remove Gaps

A DataPoint can also be placed on curve defects, like sudden jumps, in order to remove them by clicking on the Remove Gaps button.
The curve will be smoothed around the datapoint, removing sudden jumps. You can use the Undo button to revert its operation.

Gaps removal algorithm reads two DataPoint settings which can be properly configured to obtain the desired output:


	Remove gaps range: Number of points surrounding the DataPoint that will be scanned for jump removal.


	Remove gaps threshold: A limit above which the distance between two points is considered a jump that should be removed.




The threshold is automatically configured according to the range and the selected surrounding, so that any point above the mean scattering should be flattened out.







          

      

      

    

  

    
      
          
            
  
Misura™3 Data Import

Misura™4 can access data acquired from measurement instruments operated by previous Misura™3 software. By enabling the Misura™3 data import function, you can open any Misura™3
database, navigate through stored tests and get a preview of images, then convert the requested tests to the latest Misura™ file format.

Once the test data has been converted and stored into the newer format, it can be opened and used exactly as any other Misura™ file, taking advantage of nice vector
plotting, flexible data storage, reporting, and advanced math operations.


Limitations


	The Misura™3 data import function works only on Microsoft Windows™ OS.


	Misura™3 tests does not contain all the metadata generated by a newer instrument. Part of the metadata needed for correct interoperability is guessed or simply
filled with a default.


	For the above reason, Misura™3 data import should be considered experimental and might lead to unexpected or wrong results.







Enabling the Misura™3 import function

The import function can be configured in the Preferences panel. This panel is accessible from the Help menu in Browser and from the Misura menu in
Graphics.

You find a specific Data Import tab where you can enable or disable compatibility mode. After enabling it, click Save button (upper-right), then exit
from any opened Misura™ window.




Opening Misura™3 databases

The import function is available both in the Browser and in the Graphics applications.


From Browser


	Open the Browser app. Amongst recent items, you will notice a new empty column named Recent Misura 3 databases.


	If no recent database is listed, open a new one using the Add button.


	You can select a previously opened database from the list of recent paths by double-click or by clicking on Open Selected button at the bottom of the
list.




When a database is selected either ways, a Database Dialog opens. Multiple database dialogs can be opened at the same time, remaining active in the Browser’s
Database tab.

By double clicking on a test row, the test is converted to the latest Misura™ format and immediately opened in a new Browser tab.

Now all advanced Browser operations and functionalities are available.




From Graphics


	In the Graphics app a new Misura3 menu appears on the right of standard Misura menu, in the top menubar (File, Edit, etc).


	Recent Misura3 databases submenu lists recently opened databases and lets you open a new one via Open.. menu action.


	When a database is selected, a Database Dialog opens.




By double clicking on a test row, the test is converted to the latest Misura™ format and immediately added to the current graph.

It is now possible to create beautiful and complex plots out of Misura™3 data.




The Database Dialog

The Database Dialog lists all tests contained in the database, in reverse chronological order.

Simple searches against test name can be performed via the text input on the bottom of the list, followed by a click on “Query” button. The listing can also be
restricted by test type, using the chooser menu.

If a selected test contains images, they will be previewed on the bottom of the dialog.

Below the query input line there are controls about how the format conversion should happen. Using these controls it is possible to force/avoid the overwriting
of any previously converted file.






Quick Start: Correcting a Flex test from Misura™3 database

A common task to be performed with Misura™3 data is to correct a Flex test with its corresponding calibration test. The following Quick Start explains how to
achieve this result in a reversible way.


Getting a Misura™3 example database

Please download the  example Misura3 database [http://dx.doi.org/10.7910/DVN/9LLJLL] for a pre-populated database you can use to follow this Quick Start. Extract the folder wherever and point to
the misura3_sample.mdb file herein contained when asked to open a Misura™3 database.






Opening the output file in Graphics app


	Run graphics.exe application from the folder where you extracted Misura™, or run the link you created on your desktop.


	Select Misura3 menu, Recent Misura3 databases submenu, and click on Open button.


	Browse to the location of your Misura™3 database, select and open it.


	From the Database Dialog, search for a fleximeter test and its calibration test. Double click on each row in the listing in order to open both.


	Each file will be converted and loaded into Graphics, then displayed as a tree of datasets in Misura Navigator right window area. Both datasets d (displacement) are already plotted in with two different line styles.


	If the Misura Navigator area is not visible, you can show/hide it by clicking on menu Misura ‣ Opened Tests Navigator.




Misura Misura™ Navigator is the tree of recorded datasets organized by groups. Each group represents a part of the instrument or of the measurement.

For example:


	/|instr| element represents the Fleximeter instrument itself. It has datasets, but contains one sample (sample0).


	/kiln element represents the furnace, and contains datasets regarding temperature control (T, temperature; S, setpoint; P, power; etc).







Interacting with the Data Plot

The Misura™ Navigator tree is the gate to the most important actions you can perform on the data plot.

In order to plot one more dataset (for example the temperature setpoint):


	Right-click on the dataset you wish to plot on the Navigator tree (/kiln/S).


	Select the Plot action from the context menu.




The same apply for removing a dataset and all its related objects from the plot. The Plot action will be checked if the curve is visible, unchecked if not
visibile.

The setpoint curve plot is now referred to its own axis labelled S (°C). To better compare temperature and setpoint, it is useful to refer the setpoint plot
to the temperature axis:


	Click on the setpoint curve on the plot area window. Visualize the Properties area. If it is not visible, click on menu View ‣ Windows ‣ Properties window.


	The Properties area lists all the properties of the plotted curve. Search for the bold Y axis entry.


	Change Y axis from ax:S to ax:T. The curve will be immediately referred to the T (°C) axis.




The S (°C) axis loses its scale (it’s now from 0 to 1). It’s no longer useful, so you can hide it:


	Click on the setpoint curve on the plot area window, view Properties area.


	The first entry is Hide. Check the checkbox. The axis disappears.




You can freely move any axis by clicking on it and dragging.


Viewing flexion in micron unit

The /flex/sample0/d dataset represents flexion. It is recorded in microns and automatically converted to percentile on dataset loading, but is frequently
useful to analyze it as an absolute value in microns. The percentile is calculated towards the distance between the flex rods, set before starting the test.

Follow these steps to convert the curve back to microns:


	Locate the d (/flex/sample0/d) element in the Navigator.


	Right-click and select the flagged action Percentile.


	A dialog will appear. Click Apply.


	A new temporary label in the dialog confirms the dataset was created (Done). Click Close.


	If the curve is currently plotted, you immediately view the effect in the graph.


	By right-clicking again on the dataset node the Percentile action is now unflagged.




It may happen that the operator forgot to measure the sample, or inserted a wrong initial dimension. If the thermal treatment modify the structure of your
material, the test must be repeated. In case you are able to recover the correct intial dimension, or you are confident that you can measure it after the test
run, you can change this value on the output file.


	Locate the d element in the Navigator tree.


	Right-click and select Set Initial Dimension.


	Insert the correct value in Initial dimension value.


	De-select OR, automatic calculation based on first points checkbox.


	Click Apply then Close.




If the curve is currently plotted in percentile, you will se the axis scale changing accordingly to the new initial dimension set.




Correcting sample flexion with a calibration curve

Once both sample test and calibrationt test are loaded, it is possible to subtract the calibration curve to the test curve.


Hint

Although Misura™ allows to perform operation between curves with unrelated heating cycles, in order for the correction to be meaningful, you should always compare curves obtained with excactly the same heating cycle and starting from approximately the same temperature.



In order to do operations, you should select two datasets at the same time by keeping the Control key pressed while you click on their nodes in the Navigator
tree.


	Select the /flex/sample0/d node from the sample test tree you wish to correct.


	Keeping the Ctrl (control) key pressed, select the corresponding /flex/sample0/d node from the calibration test tree.


	Having both d nodes selected, right-click on one of the two and select Correct.


	A new dialog will open, Compute: Curve Operation. Select a new name for the output dataset (eg: correction) in the Output dataset name field.


	Click Apply button.


	The Navigator will update showing the new curve as CurveOperation(….). If not, right click in the blank space and select Update view action.




You can plot the corrected dataset as usual by right-click, and compare with the previous, not corrected curve.


Hint

The correction dataset node will appear many times in the Navigator tree. It is shown as child of each dataset upon which it depends for its calculation (both /flex/sample0/d datasets and both /kiln/T). Be careful to execute operation on the node stemming from the sample test root, otherwise it might be performed using wrong temperature or time references.








Additional Test Configurations

The most relevant configuration options used for the test run and Misura™3 conversion can be displayed following these steps:


	From the Misura Navigator, locate the root of the tree corresponding to the test you wish like to view.
The root node shows the name of the test and a (N:) notation, where N is a number >=0.


	Right click on the root node and select View from the context menu.




A Test Window will be opened showing an embedded plot and a Test Configuration area. The Test Window is divided in three areas:


	A menu bar in the upper part of the window


	A right area called Test Configuration. It is divided in 4 vertical tabs: Measure, Thermal Cycle, Sample0 and Results.


	A central area displaying movable and resizable sub-windows, where you see the Data Plot window.





Measure overview

The first Measure tab contains the list of options regarding the test run.

Detect the following:


	Name: Name of the test run, the same the test had in Misura™3 database.


	Comment: Note about the test, imported from the database.


	id: Path of the Misura™3 database, followed by a vertical bar and the test id (eg: C:essmisura.mdb|00137F)


	uid: Unique id generated during conversion.


	Test date: Date when the test started.


	Test duration: Total test duration in seconds.







Thermal cycle

This tab contains a table with points defining the thermal cycle and a graph with a cartesian representation.

The graph displays two curves: the red line is the setpoint temperature; the blue line is the heating rate.

If you cannot see the axes and their labels, enlarge the application window and the Test Configuration area.




Sample data

Most relevant data in the Sample0 tab are:


	Name: The same as Measure name.


	Comment: empty label.


	Initial dimension: initial dimension set by the operator.


	Initial width: only applicable to Microscope tests.












          

      

      

    

  

    
      
          
            
  
Misura™ Flash documentation

Misura™ Flash is a post-analysis tool for reading, organizing and processing data obtained from
FlashLine instrument control software running on TA Instrument’s flash products.

Misura™ Flash extends the functionality of Misura™4 software: it is build upon the common platform explained in the general documentation.

It currently supports the calculation of thermal diffusivity from flash thermograms,
according to advanced curve fitting models as:


	Gembarovic Two Dimensional Model


	In-Plane Model


	MultiLayer Model (two and three layers)




After a new Misura™ installation, the Flash functionality is deactivated by default.
To activate it:


	open the Misura™ Browser


	from the menubar select Help ‣ Client configuration


	Navigate to the Data import


	Write the word thegram in the Import plugins by name option


	Click upper-right Save button


	Close and reopen the Misura™ Browser





Contents:


	Quickstart
	From FlashLine to Misura™ Flash
	Test properties

	FlashLine results

	Plotting





	Calling a curve-fitting model
	Model plot

	Viewing the results









	Importing FlashLine data
	Double import

	Locating the converted file





	Wizard Tutorial
	From FlashLine to Misura™ Flash
	Wizard: General Options

	Wizard: Shot Selection

	Wizard: Modeling

	Wizard: Shot Analysis

	Wizard: Segment Analysis

	Wizard: Sample Analysis

	Wizard: Test Analysis









	Data Interface
	Navigating configurations
	Measure tab

	Sample tabs





	Navigating results
	Loading reference data





	Summary Plots
	Sample Plot

	Segment Plot

	Shot Plot

	Model Plot





	Dynamic Test Configuration tabs

	Plots Board

	Breadcrumbs





	Flash Models
	Fitting models from the Navigator
	Sample Geometry

	Flash Geometry

	Start Values

	Optimization Settings





	Recursive Model Run

	Analyzing results

	Repeating a model fitting

	Gembarovic Two Dimensional Model

	In-Plane Model

	MultiLayer Model





	Global configuration preferences
	Import FlashLine to default database

	Preferred FlashLine Model

	Preferred Curve-Fitting Model

	HalfTimes for analysis duration

	Use Center of Gravity to detect initial time

	Show HalfTime multiple on thermograms













          

      

      

    

  

    
      
          
            
  
Quickstart

This step-by-step guide will explain all actions required to:


	import a FlashLine data folder into Misura™,


	review and plot the results,


	configure and run a curve-fitting model.





From FlashLine to Misura™ Flash

Misura™ Flash needs to convert and compress a FlashLine test folder into a single HDF5 file in order to elaborate it.


	Open the Misura™ Browser by double-click on browser.exe.


	Locate the Data Sources sub-window, under the first Databases tab.


	Click on the Import button under the Recent files: column.


	Navigate to the TestInformation.xml file, located in the root of your FlashLine test folder, and click Open.


	The import process will require some minutes, depending on the speed of your computer,
disk and network connection if the file is remote. The progress will be indicated by a dialog window containing a progress bar.


	After the import finishes, the file will be opened in a new tab, named after the title of the test.


	The default Summary Plots is shown.




More details on these steps, and alternative ways of importing files, can be found in the Importing FlashLine data section.


Test properties

Most FlashLine properties are mapped into Misura™ components, accessible through interface elements.


	Locate the Test Configuration right-area.


	Identify lateral vertical sub-tabs on the right and activate the Measure tab.


	Observe as the Test title and Test ID corresponds to your original FlashLine test.


	Activate the Sample 1 tab and check that Sample title and Sample ID
are correctly reported from the FlashLine test.




For more details and a mapping between FlashLine and Misura™ fields, please read Navigating configurations.




FlashLine results


	Activate the Measure vertical sub-tab on the right of Test Configuration.


	The last entry is Summary. This is the grand-summary of all diffusivities contained in the test.
It is thus quite complex to navigate.


	Right-click on Summary and select the Detach action.


	The same table will open in a new, enlargeable table. Column headers contain the sample name and the diffusivity type.


	Right-click on the header and select Rotate for a more confortable view.


	Read Tables for more controls.




Numerous partial tables are contained in Sample <N> tabs.


	Activate Sample 1 tab. Deactivate the Configuration section checkbox. The Results section will remain active.


	Locate the Half Time table by scrolling through the panel.


	Right-click on the second cell (Half Time (s)) of the first row.


	From the context-menu, select Equilibrium at <X> (T<X>) (where <X> is the temperature of the segment).


	Select menu action List aggregated options.


	Review diffusivity from each single shot at the selected temperature. Each shot contributes to the mean value
displayed in the column cell from which the context menu popped out.




The component’s tree can be reached anytime also by right-click on vertical tabs labels’ of the Test Configuration area.


	Right-click on Sample 1 tab label.


	Select Configure.


	A new window will open, displaying the configuration tree spawning from Sample 1 component.


	Expand any T<X> node on the left tree (where <X> stands for the temperature of the segment).


	Double-click on a N<Y> leaf node (where <Y> is the shot number).


	Individual shot information will appear in the right area.




Important shot information, contained in the Configuration section, are:

[image: ../_images/shot_main_config.png]

	Setpoint, the target temperature of the segment


	Temperature, the actual temperature recorded at the beginning of the shot.


	Stable temperature sub-option can be activated by clicking on the + button.
Tells if temperature value was stable enough.






	Shot duration and Frequency




The Results section contains all diffusivity results.

Shots contain also a Baseline tab containing baseline information.

[image: ../_images/shot_baseline_config.png]

	Pulse start time calculated at the onset of laser pulse


	Pulse center of gravity calculated in the center of gravity of laser pulse (Use Center of Gravity to detect initial time)


	Slope and Intercept determine detected baseline linear regression


	Fitted exponential pulse checkbox indicate if the laser pulse could be successfully fitted with an exponential function







Plotting

The navigator is the most explicit way of performing plotting operations.


	Activate the Misura™ Navigator vertical tab in Test Configuration area.


	It is divided into Data, Properties, Formatting and optionally more horizontal tabs.
Ensure the Data tab is active.


	Right-click on sample1 node of the tree. Tree nodes can also be addressed by their full path: /flash/sample1.


	Select Sample Plot context-menu action.


	A Sample Plot is created and displayed.




Default plots can be generated also by directly interacting with currently plotted curves.


	Right-click on a point-cloud representing the individual shot values for a temperature.


	Select the Node submenu. Notice as this shows exactly the same actions as
if you clicked on the corresponding T<X> node on the navigator.


	Select the Segment plot action, which will generate a thermogram overlap plot
for the selected temperature segment (Segment Plot).


	Now right-click on any thermogram, select again Node ‣ Shot plot.


	This will display the shot plot alone.





Zooming

Most common task on a shot plot is zooming in and out. There are several ways.


	Click on the [image: zoomin] toolbar button.


	If you now hoover on the plot, mouse icon will be a sort of cross.


	Click on any point of the plot, then keep the left mouse button clicked and draw the rectangle you would like to zoom into.


	When you release the mouse, axes ranges will adjust in order to visualize only the selected rectangle.


	Click on the left-most white arrow to exit from the zooming tool.


	Click on [image: zoomout] toolbar button to reset all axes ranges to automatic.




Another method is by selecting an axis, then use the internal black square handles to move the ax range wherever you like.
Instead, if you need to precisely set axes ranges:


	Select the axis.


	Activate Navigator vertical tab in Test Configuration, then Properties horizontal tab.


	Set Min and Max according to your needs.







Browsing plots

Generated plots can be considered as pages of a larger document. Each time a plot is generated, a new page is added to the document.
To browse document’s pages, you can click on [image: pageprev] [image: pagenext] arrows on the toolbar.

After many plots are created, it might become cumbersome to navigate through them.

The Plots board area keeps an organized view of all plots generated in the current document.


	Generate all sample plots, by double-click on all sample nodes in the navigator tree.


	The board still shows only a screenshot of the initial overview plot, because it is showing the root level of the hierarchy.


	Click on the down arrow in the right area of the board. The board fills with all the sample plots generated before.


	Click on a sample plot screenshot. The corresponding plot will be loaded in the main plot area.


	Now generate some shot plots by double clicking on shot nodes in the navigator.


	Navigate one level down with the plots board’s down arrow.


	All generated shot plots are listed.


	Now click the up arrow to navigate in the upper level of the hierarchy.


	Click the home button to go straight to the root level.




Learn more in the Plots Board section.








Calling a curve-fitting model


	Right-click on a shot node on the navigator.


	Select the curve-fitting model you would like to run (eg: Gembarovic 2D).
The model runner dialog will pop up in a new window.


	Configure the Flash Geometry and Start Values.


	Click Ok.


	Models can take minutes to run. A progress bar dialog will keep you informed about the approximative progress.


	When the execution ends, a new node will appear in the navigator, as a leaf of the shot node starting the calculation.


	The node is named after the model, eg: gembarovic.




Learn more in Flash Models.


Model plot


	Locate the output node generated by the model run and right-click on it.


	Select Model plot action.


	The model plot will appear in a new document page.




[image: ../_images/plot_model.png]
Learn more in Model Plot.




Viewing the results

Model run results are always repeated in two components (or navigator nodes): the model’s output and the shot.
These are visible as Test Configuration vertical tabs when the Model Plot visible.

Both node and shot configuration panels display an additional horizontal tab titled after the model (eg: Gembarovic2D), after the Main tab.

The Main tab of the shot panel shows an additional field named after the model’s diffusivity output.

New model’s diffusivity tables are added to the parent segment and to the sample, collecting the only one diffusivity point we calculated.

Learn more in Analyzing results.









          

      

      

    

  

    
      
          
            
  
Importing FlashLine data

Flash functionalities have been implemented in the Misura™ Browser.

FlashLine saves each data item in a separate file. This large number of files is then organized in a hierarchy of directories.
FlashLine data strcuture cannot be directly opened by Misura™ Flash: a conversion procedure will be needed in order to compress every data file into
a single test file.

Data import functionalities are available from the Data Sources base tab in the Browser.

The import procedure will start when the TestInformation.xml file either dragged and dropped onto the gray area in the Databases tab,
or selected from the filesystem after clicking the Import... button.
Other files which will trigger the import procedure are the shot files with .fw0 or .fw1 extensions (like 00101001.fw0).

Opening any other file will abort the procedure.

When the import starts, a progress bar will appear in a popup-up window. A Log button allows to follow the conversion of each file and each shot.

Upon successful completion, the resulting file is directly opened in a new browser tab.


Double import


	In the case the user attempts to import a file which was already converted in the past,

	and still existing on the file system, a dialog will prompt the user to choose what to do.






	Open, will just open the already converted file, without converting it again


	Rename, will import the file again, and save it with a different name


	Overwrite, will delete the old file and import all the data again


	Cancel, abort any action and just exit the dialog (same effect as clicking X button)




Most of the times it is advisable to just Open the old file and save the long import procedure.




Locating the converted file

The converted file will be added to the default database index, so that the user will be able to query all previously converted tests.
Available database indexes are visible in the second column of the Data Sources subwindow.
If the user has not configured additional indexes, only the default one is visible.

During the conversion, data is copied from the original location into a compressed and optimized HDF5 file.
By default, the file is in the user folder on the local computer, under a flash subfolder in the default database directory.

The location of the default database is MisuraData under the user home folder.
On most modern windows systems, it will be something like C:\Users\<username>\MisuraData.

The default database name and location is visible under Default Database preference.







          

      

      

    

  

    
      
          
            
  
Wizard Tutorial

This step-by-step guide will explain how to:


	Open and use the wizard built into Misura™ Flash,


	Navigate through the wizard’s different functionalities,


	Run model analysis on shots, segments, and samples.





From FlashLine to Misura™ Flash

Misura™ Flash needs to convert and compress a FlashLine test folder into a single HDF5 file in order to elaborate it.


	Open the Misura™ Browser by double-click on browser.exe.


	Locate the Data Sources sub-window, under the first Databases tab.


	Click on the Import button under the Recent files: column.


	Navigate to the TestInformation.xml file, located in the root of your FlashLine test folder, and click Open.


	The import process will require some minutes, depending on the speed of your computer,
disk and network connection if the file is remote. The progress will be indicated by a dialog window containing a progress bar.


	After the import finishes, a pop-up dialog will ask to Start the Wizard or open the Default Plot. Select Start the Wizard for now.





Wizard: General Options

The Misura™ wizard will open to the General Options page, where different parameters for file can be set, such as:


	Click the drop-down menu next to Preferred Curve-Fitting Model and select the desired model for analysis of the test.
Note: This is the only selection that is mandatory to set to move to the next step in the wizard.


	To set a Diffusivity Reference for the whole test, select the an option from the second drop down menu. This is step is optional.
Note: Set individual reference values for each sample by clicking on the check box to expand the sample options, and then select a Diffusivity Reference.


	To set a System Geometry for the whole test, select an option from the third drop-down menu. This step is optional.
Note: In some cases, |f| will automatically determine the system geometry and import it into Misura™. If that is the case, this option may be selected already, you can override value.
Also, like Diffusivity Reference, you can set a differnt System Geometry for each sample.




At the bottom of the Wizard view are the controls for navigating through the Wizard. At this point, click Select Shot to move to the next section.




Wizard: Shot Selection

The orange arrows highlight the flow in selecting a shot to model:


	Select a sample from the rightmost box.


	Once the segment values appear in the middle box, select a temperature value.


	Select a shot from the final box.


	A preview of the shot will be shown in the middle window.




Click Modeling to move to the next section.




Wizard: Modeling

This section of the Wizard is for prototyping parameter values for the analysis of a shot. Below is a description of the three main components of this page of the Wizard:


	The shot on display:




[image: ../_images/wizard_plot.png]
This is a normal shot plot with 4 colored lines on it, each representing differnt model parameters:
- Start Time represents the Analysis start time parameter.
- End Time represnts the Analysis end time parameter.
- Tmax represents the Tmax parameter.
- Base line represents the Baseline level parameter.
You can click and drag each line to test different values.


	The parameter window:




[image: ../_images/wizard_params.png]

	This parameter window will initially show parameters that a user may commonly alter and test.


	The values in this window change a line in the shot plot gets clicked and dragged.


	If a value is changed in this window, the corresponding line in the shot plot will move to match the parameter value.


	To access all of the model parameters that a user can alter, click on the plot.





	The geometry diagram:




[image: ../_images/wizard_diagram.png]

	This diagram is a representation of the sample and geometry.


	The labeled numbers match the values set in the sample geometry section of the parameter window.


	To view the Sample Geometry and Flash Geometry parameters in the parameter window, click on the diagram.




Before running a model, test out some of this functionality:
#. In the parameter window, click the up-arrow on the value of Halftime multiple for endtime a couple times.
#. Notice the line for End time move a short distance to the right.
#. Now, select the End time line by clicking on it.
#. Click and drag the line back left, roughly to where it began.
#. The value for Halftime multiple for endtime will decrease to match the End time line.
#. The same behavior will be observed for each line on the shot plot.
#. Now click the geometry diagram.
#. Notice that the parameter window now has the parameters for Sample Geometry and Flash Geometry*.
#. Also, notice how the values for each parameter match up with the labled values in the diagram.
#. Now click on an area of open space in the graph.
#. Notice that the parameter window now contains all changeable parameters relevant to the model.

Once happy with the values for the model, click Run: Shot > to run the analysis.




Wizard: Shot Analysis

Once the model has finished running, it is time to analyze the results:


	The model plot is displayed in the wizard. The top half of the plot is the curve fit, and the bottom half is for the residuals.


	In the top left of the plot is the calculated diffusivity value for the model.
Note: if a reference was set, then it will appear underneath the calculated diffusivity along with the percent difference between the two.


	At the top of the parameter window, there is a tab for results, if the user would like to see more information from the analysis.


	If the results are unfavorable, you can alter parameter values the same way as in the above section for Wiard: Modeling. Click Run: Shot > to run the model again.


	If happy with the results, you can run a recursion.


	To run a segment recursion, click Segment >.


	The pop-up provides a a list of all the parameter values set for the model incase you want to review them. Also, you can opt to skip running shots that were already analyzed.


	Click Ok in the pop-up to run the segment.




Once the segment completes, the wizard will display the segment sumary plot.




Wizard: Segment Analysis


	The segment plot is on display.


	In the top left corner of the plot is the table summary of the results.


	There is a red vertical line on the plot which can be dragged to any X coordinate to align the shots at that coordinate.


	Next, you can run a sample recursion by clicking Sample >, but before you do, check out the hints below.




Hint 1: To view a specific shot, right click on the button < Select shot and then left click on one of the drop down options.
Hint 2: To run the segment again, you may alter parameters to how you want, then click Segment >.




Wizard: Sample Analysis

Once the sample recursion completes, the wizard will display the summary sample plot.


	View the sample plot.


	At the bottom left corner of the plot is the table summary of the results.


	Next, you can run a recursion on the whole test by clicking Test >, but before you do, check out the hints below.




Hint 1: To view a specific shot plot or segment plot, right click on the button < Select shot or < Segment and then left click on one of the drop down options.
Hint 2: To run the sample again, you may alter parameters to how you want, then click Segment >.

Warning: Test recursion may take a while.




Wizard: Test Analysis

Once the test recursion completes, a sample test plot will be displayed.

Click the Save button to save your analysis progress to another version of the test file.

Click the Close Wizard button to exit the wizard view and operate misura from the default view.









          

      

      

    

  

    
      
          
            
  
Data Interface

This chapter offers additional information tailored at Misura™ Flash users, which might not be sufficiently covered in the general Misura™ documentation.

Flash data is organized in a highly hierarchical interface, designed to allow to both have a quick overview and dig deeper into every detail.


	For each Sample (S), we have multiple segments or equilibrium temperatures (T):


	For each Equilibrium Temperature (T) we have multiple shots


	For each shot (N), we have:


	raw thermogram,


	laser pulse


	corrected thermogram


	one or more curve-fitting results






	Each shot can be fitted against one or more models (M), with different model parameters each tim


	For each set of model parameters we have:


	Fitting Results


	Fitting Errors








So the hierarchy is: S/T/N/M, or sample, temperature, shot, model.

This structure is represented in the Misura™ Navigator tree:

[image: ../_images/node_select.png]
And in the global component’s panel, from Settings ‣ Global:

[image: ../_images/global_panel.png]
Each entry in those trees represents a component of the above hierarchy,
and each component has several options representing either results or configurations.


Navigating configurations

Misura™ Flash tries to read most of the test information contained in the original test FlashLine structure, except few debug outputs.

The FlashLine configuration dialog is reported here to better understand field mapping:

[image: ../_images/flashline_test_config.png]
This information is organized across Misura™ user interface elements. This paragraph helps locating most important metadata.

Most information is shown in the Test Configuration area.

[image: ../_images/test_configuration.png]
This area is divided into several tabs:


	Measure tab contains global test information - eg, not specific to a single file.


	Navigator tab contains Misura™ Navigator controls.


	Sample<N> tabs, one for each <N> samples, contain data which is specific and potentially different for each signle sample.





Measure tab

Relevant Measure entries are explained below:


Measure tab mapping to FlashLine






	Misura™

	FlashLine

	Notes





	Test title

	Same

	


	Test ID

	Same

	


	uid

	None

	Automatically generated by Misura™ to uniquely identify the test



	Test date

	Date

	


	Test duration

	None

	Total time elapsed from the start



	Operator

	Same

	


	Preferred FlashLine Model

	None

	The preferred diffusivity value to be displayed in plots.



	Preferred curve-fitting model

	None

	The default curve-fitting model



	Summary table

	None

	A table listing all diffusivities, for all temperatures and all samples









Sample tabs

The sample tab is divided into two subsections:


	Configuration contains sample properties as entered by the user.


	Results. contains diffusivity results.




FlashLine displays sample properties in a table under the general test information.
FlashLine table columns are mapped here:


Sample tab mapping to FlashLine






	Misura™

	FlashLine column

	Notes





	Sample title

	Third, namesake column

	


	Position

	First, namesake column

	Carousel position



	Thickness

	Fourth, namesake column

	


	Diameter

	Fifth, namesake column

	


	Weight

	Last, namesake column

	


	Test type

	Specific Heat/Condictivity global checkbox (bottom dialog).

	Not all test types can be directly mapped to a FlashLine interface element.
Some of them are global (eg: equal for all samples).



	Sample ID

	Second, namesake column

	


	Expansion type

	Use Expansion dialog

	Type of expansion fitting function



	Expansion reference

	Use Expansion dialog

	Expansion reference data



	Diffusivity Reference

	None

	See Loading reference data



	Specific Heat Reference

	None

	


	Density Reference

	None

	










Navigating results

Configuration panels, tabs, sections, groups and options are introduced in the general Misura™ documentation about Components and options.

A prominent role is played by aggregates. Diffusivities and associated errors are calculated for each shot and for each model run, in the (N) and (M) nodes above.
Parent nodes are informed of these results with a mechanism called option aggregation, explained in Aggregates.

In this way, each segment node (T100) can calculate and display the mean value across diffusivities of its shots (N1, N2, N3…):

[image: ../_images/segment_aggregate.png]
And a tabular representation, by shot temperature:

[image: ../_images/segment_aggregate_table.png]
A sample (S1) can build a table with temperature-diffusivity mean from all its temperature segments (T50, T100, T150…):

[image: ../_images/sample_aggregate_table.png]
And the whole test can display a global summary table containing all values, from all samples (S1, S2, S3…).

[image: ../_images/aggregate_summary_table.png]

Loading reference data

Standard reference materials can be defined for each sample, in the Sample N right panel.

If all samples have the same reference, it can be defined just on time.

[image: ../_images/diffusivity_reference_selection.png]
After a selection is made, new output tables and values will be generated in each sample, segment and shot, containing reference data.

New reference datasets will also appear in the Misura™ Navigator under the sample and segment nodes,
so they can be plotted by double-clicking or right-click then Plot.






Summary Plots

When a test is opened, a summary plot will display Clark&Taylor diffusivities with temperature, for all samples.
The diffusivity method can be changed by setting Preferred FlashLine Model to any supported technique.

[image: ../_images/plot_summary.png]
Other summary plots can be created from the navigator, by double-clicking on supported nodes, or right-click and selecting the associated plot action.

The following animation illustrate the process of creating the default plots as hereafter explained:

[image: ../_images/default_plots.gif]

Sample Plot

By selecting Sample Plot or double-clicking on a sample node, a new plot will be created with diffusivities by temperatures of the selected sample.

It will additionally display point clouds around each mean diffusivity value, representing the diffusivity obtained from each shot.

[image: ../_images/plot_sample.png]



Segment Plot

A Segment Plot will overlap thermograms from all shots contained in a segment.

[image: ../_images/plot_segment.png]



Shot Plot

The Shot Plot simply displayes the thermogram.

[image: ../_images/plot_shot.png]



Model Plot

Any curve-fitting model can create a Model Plot. The page is splitted in two sub-plots:
the upper part shows the thermogram and model output; the lower part shows the residuals.

[image: ../_images/plot_model.png]
In case of model re-run, this model will only partially update. It is preferrable to re-create it from zero,
from the Model Plot action in the navigator.






Dynamic Test Configuration tabs

As the current plot changes to display data from different samples, segments and shots,
the vertical tabs in the Test Configuration load relevant component’s information.

The default Summary Plots, for example, displays diffusivity curves for all samples.
The Test Configuration accordingly lists one configuration tab for each sample.

A Sample Plot, plotting data from one sample and multiple segments, will show both relevant sample’s tab, and one tab for each segment.

With the same logic, Segment Plot offers the loaded segment tab plus one tab for each shot,
and the Model Plot both the shot tab and the model output tab where model configuration and results are saved (for example, gembarovic).




Plots Board

Plots are organized as pages of a document. Pages can be browsed with the blue left/right arrows on the upper plot bar.

When many plots are created, navigation can become quite confusing. The Plots Board and the breadcrumbs navigator
allow to view and manage plot pages in a hierarchical way.

The plots board displays pages screenshots side-by-side, as a plain list.
But not all pages are displayed at once: only those sharing the same hierarchical level.

[image: ../_images/plots_board.png]
All sample plots will be listed together, as well as segment plots or shot plots, but they will never mix.
The example shows numerous shot plots, and a model plot (classified at the same hierarchical level as shots).

By left-clicking on a plot screenshot, it will appear in the main plot window.

If the left mouse button is kept pressed, or with a right-click, a context menu will appear, allowing to:


	Explicitly Show (the same as single click)


	List all children: will show only plots containing curves which are dependent from those contained in this plot.
For example, if only children of a sample are selected, only plots from that sample’s shots will be listed.


	Delete the plot page


	Export the page to pdf




The board also shows three buttons:


	up and down arrow, to navigate in the hierarchy levels


	home, to reset all selections and display the level corresponding to the current plot page




The following animation illustrates the plots board in action. Notice also as the Breadcrumbs updates accordingly.

[image: ../_images/navigating_plotsboard.gif]



Breadcrumbs

It appears as a simple sequence of labels, representing the current hierarchical level.
Each label can be clicked and gives access to any other plot page in that hierarchical level.

[image: ../_images/breadcrumbs.png]
The principle of the breadcrumbs is similar to the plots board, except that it does not include screenshots and can only switch to the selected page,
with no additional actions like delete etc.







          

      

      

    

  

    
      
          
            
  
Flash Models


Fitting models from the Navigator

Flash post-processing actions are currently accessible from the Misura™ Navigator.
The Navigator represents all the data contained in one or more test runs as a hierarchy of nodes.
Usually the tree has only one root node, corresponding to the opened test.

Right clicking on a node gives access to specific actions, including those related to Flash models.

Child nodes might represent:


	A component. Samples, segments, shots are componets.
The component configuration can be accessed via right-click and Configure action.


	A dataset, which can be plotted, manipulated and edited.




The root node always has a kiln sub-node, containing information and sub-nodes related to thermal control, and a flash sub-node.
The flash sub-node always contains measure sub-node, with general test configurations (name, number of samples, instrument serial number, etc)
and Aggregates summarizing all diffusivity results.
The measure node Configuration panel is usually displayed in the right interface area (Test Configuration).

The flash node also presents one sample<N> node for each sample in the test (eg: sample1, sample2, sample3...).

Samples have one segment sub-node for each equilibrium temperature.

The general procedure to execute models or related calculations is:


	Select the navigator node which will be subject to the desired action.




[image: ../_images/node_select.png]

	Right-click on the node. The node context menu will appear.


	Select the model to run (Run …).




[image: ../_images/node_menu.png]

	If the model has options, a dialog box will allow the user to inspect and modify default model parameters through a Configuration panel.




[image: ../_images/model_dialog.png]

	As the model parameters are confirmed by Enter keystroke or by clicking the Ok button on the bottom of the dialog, computation starts.


	The output of the calculation will be shown in the navigator in the form of additional sub-nodes, containing results.


	Additional actions can be performed on the model output node (plotting according to a template, re-running the model, etc).




[image: ../_images/output_node.png]
When the clicked node represents a single shot, the model is fitted against that shot thermogram.
If parent nodes are clicked, for example a segment node or a sample node, a recursive execution will be performed.

Model dialogs contain some common groups of options, which are generally explained in the following sections.
Presets or equivalent values from other nodes of the test can be loaded with the mechanism explained in Sub-options and groups.
More details are included in each model’s section.

The following animation illustrates the process of executing Gembarovic Two Dimensional Model on a single shot:

[image: ../_images/executing_gembarovic_model_and_plot.gif]

Sample Geometry

[image: ../_images/sample_geometry1.png]
This section contains basic geometric information pertaining the sample itself and, for multi-layer tests, the sample holder.
They are pre-filled with values obtained from the sample description before starting the test, and are equal for each shot in the test.
The user can anyway experiment an change them.




Flash Geometry

[image: ../_images/flash_geometry.png]
These options are related to the optics of the flash apparatus.
They should be configured according to the hardware calibration, but they can also be used as an initial guess to be optimized.




Start Values

[image: ../_images/start_values.png]
Fundamental model parameters. They must be as close as possible to the real solution.
Misura™ Flash will guess optimal values based on legacy diffusivity models and gross properties of the shot.




Optimization Settings

[image: ../_images/optimization_settings_2d.png]
This section allows to enable or disable the optimization of each individual parameter, through a series of Optimize <name> boolean options.

Moreover it allows to finely tune which region of the shot will be used as the target for the curve-fitting:


	Analysis start time and Analysis end time allow to define the analysis temporal window in milliseconds. The start time might be useful to cut interferences
due to the energy burst. The end time allows to discard excessive amount of data, which is unuseful and sometimes even detrimental.


	Halftime multiple for end time:  This option allows to define the end time relative to the halftime of the shot.
This is the preferred way to set the end time. The default is configured in HalfTimes for analysis duration.


	
	Max number of points for analysis defines the maximum number of points which will be used to perform the curve-fitting.

	If the selected shot range includes more points, an even selection of them will be dropped until this condition is satisfied.









Each model might include additional, specific optimization options.


Optimization constraints

During the curve-fitting procedure, model parameters are being varied according to mathematical criteria
in order to minimize the error between the model and the thermogram.

As models are quite complex equations, they will always offer many solutions. Most of them might have no physical meaning, while some are impossible given
additional knowledge about the material generating the thermogram.

It is thus advisable not only to set the Start Values and Flash Geometry to reasonable values, but also check that parameter’s ranges are
plausible given other material’s property.

Ranges are accessible by right-click on the option’s label, then enter the Range menu, and edit minimum/maximum values.




Minimization algorithm

The optimal parameters which best approximate any model to real data will be searched via an error minimization algorithm.

This kind of search is highly dependent on initial conditions: if they are a good approximation of the best solution, the search will be fast and successful.
Otherwise it will take longer time and the risk of finding a local minimum with little or no physical sense increases.

Misura™ Flash offers some help in this area:


	An initial guess will be attempted from legacy diffusivity models (Clark&Taylor) and from gross mathematical properties of the shot.
It’s up to the user to review and refine this guess.


	As seen above in Optimization Settings, the user can restrict the search only to relevant, unknown parameters.


	Parameters being optimized should define Optimization constraints. The algorithm will not be allowed to wander off this range.




The default optimization algorithm is ODRPACK [http://www.netlib.org/odrpack/], orthogonal distance regression.
It will work most of the times and give a good result but, because of it’s local nature,
it will usually require that the initial guess is not too far from the solution.

When the initial guess is still giving unreasonable results, a global search can be attempted using a modified Basin Hopping [https://docs.scipy.org/doc/scipy/reference/generated/scipy.optimize.basinhopping.html] algorithm.
It creates multi-dimensional grid of starting values and attempt an ODR local search from a random selection of points.
It will try until a good fit is found, the grid is completed or the search times out.

Basin Hopping options are:


	Enable global minimum search: activate Basin Hopping.


	Maximum starting points iterations: maximum number of iterations from the initial starting grid


	Minimum successful iterations: iterations needed to decide if a local minimum can be considered global and the search ended


	Maximum duration: after this timeout expired, the search will be ended and the best result selected











Recursive Model Run

Recursive model run can start from a segment, sample or test (root) node.
It will fit all thermograms contained underneath the starting node with the selected model.

Before starting the recursion, a dialog box allows the user to specify model parameters
and decide if they should be forced to some fixed value or calculated for each thermogram.

At each thermogram the algorithm will use the default sample geometry and optimization settings.
It will also try to guess the starting values for the fitting procedure, as well as the time frame
for the analyis (based on the half times option).

This behavior can be overridden by forcing any option into a fixed value in the model configuration dialog, via the enabled checkbox.

[image: ../_images/enabled_option.png]
When a configuration option is enabled before a recursion, it means its value will be fixed for all shots encountered during the recursion.
When disabled, it means a default value will be used if available, or a custom value will be calculated based on thermogram features (for example: Tmax).




Analyzing results

Results are mainly stored into dedicated output nodes in the Misura™ Navigator.
Each output node descends from the shot containing the thermogram which was used to generate it.

By right-clicking on an output node, it is possible to:


	Configure: Access configurations and results by opening a new Configuration panel.


	Model Plot: Create a default plot out of the model results (Model Plot)


	Repeat the model execution. This action will not display the model dialog and will proceed silently




The output node configuration contains a copy of the starting parameters which were used to perform the model fitting.
The panel is divided in two tabs: Main, containing just node and model name, and a section with the same name of the model (eg: InPlane),
containing all model parameters and fitting results.

[image: ../_images/conf_output_node.png]
After running an analysis, output results are automatically aggregated in result tables.




Repeating a model fitting

Fitting real data against complex theoretical models sometimes requires trial and error.
It is advisable to always try curve-fitting on few shots, then use the same parameters for few segments,
and finally extend to the entire sample or the whole test.

Misura™ offers different ways to repeat an optimization.


	A navigator context-menu action Repeat, available from the model node, allows to silently repeat the fitting.


	The optimization configuration dialog can be recalled from the shot node, using the corresponding Run model <M>.







Gembarovic Two Dimensional Model

The Two Dimensional model, named after Jozef Gembarovic, takes into account optical details - like viewed and irradiated diameters,
heat diffusion through the sample area and the exponential shape of the pulse.

[image: ../_images/jg2d.png]
Additional parameters include, under Flash Geometry:


	Outer irradiated diameter: the diameter illuminated by the energy source


	Inner irradiated diameter: an optional blind spot in the middle of the energy source


	Outer viewed diameter: the diameter viewed by the detector


	Inner viewed diameter: an optional blind spot which is not detected, in the center of the viewed circumference




These parameters can be individually enabled for optimization in the Optimization Settings group.

This model additionally supports Exponential pulse correction, if enabled and correctly fitted on the laser pulse.




In-Plane Model

The In-Plane model takes similar parameters as the Gembarovic Two Dimensional model, but with a different meaning.

Here we assume the sample is so thin, or heat diffusion is so fast, that through-thickness transmission is negligible.

Irradiated diameters are configured to create an outer doughnut, containing the viewed area after a circular section which is neither irradiated nor viewed.
In other words, the outer viewed diameter must be smaller than the inner irradiated diameter by some margin,
as this margin is used to calculate the diffusivity.

[image: ../_images/inpl.png]
The thermogram is thus the result of diffusion through this blind area of the sample.

This model does not support exponential pulse correction.




MultiLayer Model

This method is divided in two actual models, for two and three layers.

Additional options:


	Sample Geometry group shows two or three Thickness values (Thickness (1), Thickness (2) and for three layers also Thickness (3)).


	Start Values group lists additional entries for each layer (n) Density (n), Specific Heat (n), Heat Loss (n).


	For two layers only, Start Values also allows to configure the Thermal contact resistance between the first and the second layer.


	Each option listed in Start Values is also listed in Optimization Settings, so it can be optimized during the curve-fitting procedure.










          

      

      

    

  

    
      
          
            
  
Global configuration preferences

Misura™ Flash offers few configuration options which will determine default plotting appearance, parameters population, and data import aspects.

Options are contained into the general Preferences, under the Flash tab:

[image: ../_images/global_preferences.png]
Advanced options, related to default plots, are also listed.


Import FlashLine to default database


Default: True




FlashLine data will be compressed into an Misura™ file into default database location (usually MisuraData under user’s home folder).
If this option is false, the Misura™ file will be created into the same folder containing the FlashLine data - even if remote.




Preferred FlashLine Model


Default: Clark & Taylor




This option determines which model will be loaded to create default plots.




Preferred Curve-Fitting Model


Default: Gembarovic 2D




The default curve-fitting model which Misura™ will attempt to plot when loading a test for the first time.




HalfTimes for analysis duration


Default: 4




The halftime will be multiplied for this value in order to obtain the required thermogram time frame to perform a model fitting.




Use Center of Gravity to detect initial time


Default: True




While importing FlashLine data, the center of gravity of the laser pulse is always calculated and saved.
By enabling this option, any subsequent computation will use the center of gravity as the initial time of the test.
By disabling it, the onset of laser pulse will be used instead.




Show HalfTime multiple on thermograms


Default: 20




Each thermogram (“shot”) is usually longer than needed.
This options determines the maximum number of halftime multiples to plot on Model Plot and Segment Plot.







          

      

      

    

  

    
      
          
            
  
Access Management

Communication between Misura Server and Misura Client happens over an SSL-encrypted channel and is password-protected.

Server-side it is possible to define users, associate passwords and assign read and write permission levels. Users can be managed from the General configuration panel, under the users node.

The Users``section exposes the ``Users List option table, with 4 columns which can be directly edited by double-clicking:



	Name: The user name asked at login time


	Read level: The permission level for reading. Only options having a read level equal or lower than the user’s one will be visible to the user.


	Write level: The permission level for writing. Only options having a write level equal or lower than the user’s one will be editable by the user.


	Hash: The password, currently in plain text







The users object is currently reserved for service purposes.





          

      

      

    

  

    
      
          
            
  
Misura Server

Misura Server is the software component embedded in the measurement instrument. It is responsible for the control of all of the instrument’s hardware and for data recording.


Web Interface

A very basic web interface is available to retrieve test files, logs and configurations.


	Test files: https://172.16.8.68:3880/data


	Log files: https://172.16.8.68:3880/data/log


	Configuration files: https://172.16.8.68:3880/conf


	Status: https://172.16.8.68:3880/stream







Process Management


Soft-Restart

Most of the software problems will go away after a server restart, which means you just close and reopen the server application.

In order to restart the server:



	Open the Acquisition application. Connect to the instrument you want to restart.


	From the Connect menu (top-left), select Restart


	Wait few seconds, then reconnect to the instrument.










Rebooting

Rare but serious operative system issues are usually solved by an embedded computer restart. Only the controller will restart: you shall not turn off the main power.

To reboot the controller:



	Open the Acquisition application. Connect to the instrument you want to reboot.


	From the Settings menu, select Global action.


	Double-click on support entry from the tree on the left. The support configuration panel is displayed as first tab on the right.


	Locate the Reboot machine OS option and click on the button on the left.


	The reboot will immediately start. At this point you can close the Acquisition application.


	After 5 minutes you can reconnect to your instrument.










Shutting down

The shutdown command from the Connect menu will cause the onboard computer controlling the instrument to shutdown.



	Open the Acquisition application. Connect to the instrument you want to shutdown.


	From the Connect menu, select Shutdown.


	A confirmation message box will be shown.


	Acquistion app can be closed.







The onboard computer should start up automatically after next connection tentative from Acquisition application.






Upgrading

Server upgrade package might be provided as tarballs (.tar) or zipped (.zip) archives.
An upgrade archive needs to be transferred onto the instrument while it is active, and then the server process should be restarted.

Follow these steps:



	Connect to the server with admin rights.


	From main window menu: Settings > Send update package.


	Navigate to the update package (misura_pkg_<version>.tar) and send.


	The server will reboot and the client will shortly close itself.


	When you reconnect to the server, it will be at the selected version.







You can check package name and last update date in the sub-options Last applied package name and date
in the Support configuration node (Settings > Global menu action).


Downgrading

Each upgrade package which is sent to the server remains saved locally, so that it is possible to rollback any previous release.
Since this operation is much less usual, the procedure is less straightforward than upgrading.



	Open Acquisition and connect to the instrument.


	From Settings menu, select Global action.


	From the objects tree on the left of the new window, double-click on Support node.


	Activate the Status configuration section by clicking the checkbox.


	Locate the Available software versions option and select the version you want to revert to.


	Expand sub-options by clicking on the [+] leftmost button.


	Click on Apply selected software version.


	A confirmation dialog appears. Acknowledge it and close the global configuration window.


	Return to Acquisition application and command a Soft-Restart to make the changes effective.















          

      

      

    

  

    
      
          
            
  
Glossary


	ODP

	Optical Dilatometry Platform, the most complete hardware controlled by Misura software.



	CCD

	The Charge-Coupled Device responsible for digital image acquisition. The term is usually referred to mean the active camera resolution, from which one or multiple regions of interests can be selected.



	ROI	Region of Interest

	A rectangle representing a selection of the total camera resolution.



	Optical Encoder

	The entity defining, forecasting and applying the conversion factor between one motor step and the number of pixels it produces on the image.



	Misura Platform

	The measurement instrument as a whole, comprising both software and hardware components.



	Misura Server

	The embedded software component controlling the instrument’s hardware and actually performing measurements.



	Misura Client

	The user interface which allows to connect to a platform, carry out analysis, get the results, visualize, organize and post-process them.



	Instrument App

	The software component used to carry out one kind of measurement technique (microscopy, dilatometry, fleximetry, etc). The Instrument App determines the user interface appearance, and is actually the category under which Measurement Apps are furtherer specified. The user never directly starts an Instrument App.



	Measurement App

	The specific configuration used to carry out a measurement. For example, the same measurement technique might be applied to very small or very big samples, requiring different Measurement Apps which configure hardware and software in order to meet different measurement requirements. The user always starts a Measurement App.



	Analysis App

	A software component extending an Instrument App in order to add advanced functionalities. An Analysis App might add an experimental image analysis method or an innovative thermal control feature.



	Head Morphing	Measurement Head Morphing	Instrument Initialization

	The process of configuring the measuring instrument to make a specific kind of measurement. This involves many software controllers setup and moving parts.



	Loaded	Loaded Dataset	Loaded Datasets

	A loaded dataset is currently loaded into the application memory. It can be plotted and used as the input for any data processing step. Opposite of Available Dataset.



	Available	Available Dataset	Available Datasets

	An available dataset is not loaded into the application memory, but exists on the output file containing test data (it is available for loading). They are usually filtered out from the Misura™ Navigator and are not visible in data processing steps. An available dataset can be easily loaded through the use of Misura™ Navigator.



	Free Sample Positioning

	A characteritic of all ODP instrument is that samples are placed by hand with no physical constraints and very ample limiting geometries.



	Metadata

	Test metadata summarizes high-level aspects about test execution, expressed as a value, a time and a temperature. Test data contains time series of recorded values: eg how the length of the sample changes with time. A metadata is, for example, the maximum rate of change of the length: its value, the time at which it happened and the sample temperature at that time. Metadata is usually calculated runtime during the test execution, and can be replayed offline from the Misura™ Browser.



	Scripts	Script

	Small portions of source code which is executed by Misura Server during a test. Scripts are exposed to the client and can be customized by the user to meet specific control procedures or experimental morphometrics standards.



	Global Focus

	The focus distance can be adjusted for all cameras at the same time by means of a motorized translation stage. It is not possible to independently adjust the focus of each single camera. This is actually intentional as a discrepancy in focus distances usually suggests a sub-optimal sample orientation.



	HDF5

	The Hierarchical Dataset Format v5 [https://support.hdfgroup.org/HDF5/] file format used to store test data. Has .h5 extension.
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Furnace test instrument

Read Live Acquisition for a general description of the acquisition window.
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Misura™ Platform Options

A detailed descrition of each configurable option on the instrument.

TODO: explain properties.
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Misura Morphometrics

Describes the Morphometrics package.
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